Magento User Guide

The Magento User Guide is here to help you through the process of setting up your store. The User Guide begins with an
introduction to installing and configuring the basic settings for your store, and then walks through the steps to configure more

advanced settings, setting up your payment modules, creating and editing categories and products and much more.

If you have a specific question on an element within Magento you can skip to the chapter within the User Guide using the table
of contents to the right. If you are just getting started it is best to go through the User Guide chapter by chapter to walk you

through the process of configuring your store.

This User Guide is a Wiki, and as such, you should feel free to edit and add elements as you see fit.
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Chapter 1: Introducing Magento

What is Magento

Magento is a new professional open-source eCommerce solution offering unprecedented flexibility and control. With Magento,

never feel trapped in your eCommerce solution again.

Sinceitisopen-s our ce, Magentods code i s ayvi@wmwaadestocdmmeree.cdmidownldadion!| oad. Jus't

download your copy today.

In this guide we will introduce key concepts and walk you through setting up your Magento store, from installing Magento, to

entering products.

Elements and Terminologies of Magento Sites

Magento is made up of a few different elements which define the functionality, design and business logic of the site. In order to

follow along with the User Guide it is crucial that you have a good grasp of the terminologies used to describe these elements of

the Magento system. The terminologies introduced in this chapter are most likely new territory for you, so take your time and

read through them thoroughly. But most i mportantly, domdt be discc
terminologies - This chapter merely serves to introduce them, and further chapters will dig deeper into, and expand upon, these

simple definitions.

Websites and Stores

One of the most powerful features of Magento is the ability to manage multiple websites and stores from one back-end. This
allows store owners to manage stores on different URLSs, display the same products in different languages on the same URL,
along with a variety of other setups. If you will only be selling your products from one URL in one language you will not need to
use this functionality, but the ability to easily expand into additional languages makes Magento scalable as your business grows

out of your home market.

Websites

A website is made up of one or more stores which share the same customer information, order information and shopping cart.

This is a very broad term that can be adopted to define the unique needs of individual merchants.

Stores

Stores can be setup in a variety of ways, but remember that if they are part of the same website they will share certain

information.


http://www.magentocommerce.com/download

Store Views

Store Views are mainly used for different languages, so if you wanted to have a store displayed in English and Spanish, for

example, you could create the store once and create two different store views for that store.
A few scenarios to define the different uses of website and store are as follows:
Scenario 1: One Website with multiple stores

Website Dubloo Inc

Store Low-End For You FrugaI.Fo r You Hig h-End For You

Store View Low-End For You FrugaI-Fo r You Hig h-End For You

Scenario 2: Two Stores with two store views each

Website My Laptops Cheap Laptops

Stare My Laipmps | Cheap Laptops |

Store View English Spanish " English | | Spanish |

Scenario 3: One Website with one store and one store view

Website Bongo's Instruments

Store Bongo's Instruments

Store View Bongo's Instruments

The most common setup will be a one website and one store setup, but understanding the functionality of multiple websites and

stores will help you understand why certain values are defined as global defaults and why others are only assigned on the

website or store level.


http://www.magentocommerce.com/wiki/lib/exe/fetch.php?cache=cache&media=http://www.magentocommerce.com//images/uploads/terminology-scenario1.jpg
http://www.magentocommerce.com/wiki/lib/exe/fetch.php?cache=cache&media=http://www.magentocommerce.com//images/uploads/terminology-website-laptops.jpg
http://www.magentocommerce.com/wiki/lib/exe/fetch.php?cache=cache&media=http://www.magentocommerce.com/images/uploads/terminology-scenario3.jpg

Magento's Architecture

Magento is built on top of the Zend Framework, ensuring that the code base will be secure and scalable. The reasons for
choosing the Zend Framework are many, but at a basic level the Zend Framework provides an object-oriented library of code

with a committed company standing behind it.
Using this framework, Magento was built with 3 central tenets in mind.

1. Flexibility: We believe each solution should be as unique as the business behindit Magent o6s code all ows
seamless customizations.

2. Upgradeable: By separating the core code from community and local customizations, Magento can be easily
customized without losing the ability to upgrade.

3. Speed and Security: The coding standards used by the developers follow best practices to maximize the

efficiency of the software and provide a secure online storefront.

I'n this chapter we wild/l introduce key concepts and terminologies

Magento these concepts and terminologies will help as you set up your own online store.

Core

The core of Magento contains all the functionality included in the downloaded version. The core code is a collection of modules
developed or certified by the Magento core development team. Editing core files is not recommended and will disable the ability

to upgrade Magento in the future.

Local

Local extensions are customizations of Magento which reside only
local folder, so that they do not interfere with upgrades to the core code, and in order to differentiate them from community
contributions. There are different types of extensions, which we will get into in a moment, but they will all reside in the same

directory.

Local extensions function just as core code does, only the directory is different.

Community

Community contributions are just that, and when downloaded will reside in the community folder. Just like local extensions, by
keeping them separate from the core code Magento store owners are able to enjoy the additional functionality without

compromising the ability to upgrade to future Magento versions.

f

C

C



Extensions

In short, extensions are exactly what they sound like. One or more files packaged together to extend the functionality of
Magento. Strict terms and conditions prohibit extensions from modifying the core code, ensuring that any extended functionality

d o e sprofibit you from upgrading when a new version of Magento is released.

Extensions can be installed from the admin panel, or downloaded from Magento Connect. These processes will both be covered

|l ater in the book, but I ensighs | ook at the three types of ext

There are three types of extensions, and they will reside in one of the two locations described above. There are 3 main types of

Extensions.

Modules

A module is an extension which extends the features and functionality of Magento. You are probably familiar with the idea of
modules from other software, but if not, some concrete examples of modules would be additional payment gateway integrations,

or a featured items promotional tool.

Store / Store | Store C
= e B

Interface | collection of themes

-------------------- Theme | Combination of files that create the visual cutput
as well as frontend functionality

| Defines block structure

| PHTML containing (X)HTML and PHP logic tags

------------------- Skins I 55, images, Javascript


http://www.magentocommerce.com/wiki/lib/exe/fetch.php?cache=cache&media=http://www.magentocommerce.com/images/uploads/terminology-website-term.jpg

Interface

An interface is a collection of themes that determines the visual output and frontend functionalities of your store. An interface
can be assigned on either the website-level, store-level or website and store level through the admin panel. We will cover

assi gning interfaces |l ater in the book, for now |l etds take a | ook a

Themes

A theme is any combination of layout, template and/or skin file(s) that create the visual experience of your store. Magento is built

with the capacity to load multiple themes at once, and therefore distinguishes themes into two types:

A Default Themes -Every interface comes with a theme called 6defaultoé whi
assign an interface to your store, the application automat i cal |y | ooks for this themleln 6def aul t o
order to customize your store design, you can either modify this theme, or create a non-default theme in addition and load
it alongside the default. The default theme must contain all the required layouts, templates and skins to run a store error-
free and hence is the lowest theme in the theme hierarchy.

A Non-Default Themes - A non-default theme can contain as many or as few theme files as you see fit for your needs. This
type of theme is intended for creating temporary seasonal design changes to a store without having to create a whole new

default themed By creating a few images and updating some of the CSS, you can easily turn your store from a real bore to

a stand-out seasonal Christmas store.

Lets take a look at the components of a theme:

A Layouts - Layouts are basic XML files that define the block structure for different pages, as well as controlling the META
information and page encoding. Layout files are separated on a per-module basis, with every module bringing with it its
own layout file.

A Templates - Templates are PHTML files that contain (X)HTML markups and any necessary PHP tags to create the logic
for the visual presentation of information and features.

A Skins - Skins are block-specific Javascript and CSS and image files that compliment your (X)HTML. What are blocks you

ask? Good question, and dondét worry, we are al most done definin;i

Blocks

Blocks are a way by which Magento distinguishes the array of functionalities in the system and creates a modular way to
manage this array from both a visual and functional stand point. There are two types of blocks and they work together to create

the visual output.

A Structural Blocks - These are blocks created for the sole purpose of assigning visual structure to a store page. Examples

would be the header, left column, main column and footer.



Header

Left Main

Footer

A Content Blocks - These are blocks that produce the actual content inside each structural block. They are representations
of each feature functionality in a page and employ template files to generate the (X)HTML to be inserted into its parent

structural block. Examples are the category list, mini cart, product tags and product listing.

Header Links

Header
Site Navigation

Product Listing

Callout

Product
Tags
Sub Category List

Footer

Unl ess you will be developing or designing for Magento you wonot r

Compare
Prodcuts

MNewsletter

Signup

who will be developing or designing custom modules and interfaces, make sure to read Chapter 12: Designing and Developing

for Magento. Of course we suggest you read the book through first, as the next few chapters are full of helpful information.


http://www.magentocommerce.com/wiki/lib/exe/fetch.php?cache=cache&media=http://www.magentocommerce.com/images/uploads/term-blocks-structural.jpg
http://www.magentocommerce.com/wiki/lib/exe/fetch.php?cache=cache&media=http://www.magentocommerce.com/images/uploads/term-blocks-content.jpg

Chapter 2: &tting Started with
Magento

Magento is developed to take full advantage of the newest technologies available, allowing your site the
maximum flexibility without sacrificing speed. In this chapter we will look at the system requirements of Magento,
how to download and install Magento on your server, and go through an introduction to the administration panel

and key concepts when using the administration panel.

System Requirements

At the base level, Magento will require the following software.

A Linux, Windows, or another UNIX-compatible operating system

A Apache Web Server (1.x or 2.X)
A PHP 5.2.0 or newer, with the following extensions/addons:
A PDO/MySQL
A MySQLi
A mcrypt
A mhash
A simplexml
A DOMm
A curl
A gd

A MySQL 4.1.20 or newer
A A Sendmail-compatible Mail Transfer Agent (MTA)

A Magento will connect directlytoan SMTPs er ver i f you dondét have an

We also recommend the use of APC as a bytecode cache for performance improvements. You can find it in the

PECL archives here: http://pecl.php.net/package/APC. Other bytecode cache systems are not supported at this

time.

If you are unsure if your hosting company supports these specifications, please check with them. You can also
view these specifications at: magentocommerce.com/system-requirements. Once you have a hosting
environment set up with support for these requirements you are able to download and install Magento to your

server.

MT A


http://pecl.php.net/package/APC

Downloading Ma gento

Magento is free to download. Simply go to magentocommerce.com/download and you will be able to download
the software. Magento is available for download in two different versions. The installer version includes only the
necessary files needed to begin the installation process and will be all that is necessary for most cases. If you are
planning on installing multiple versions of Magento the full version will be more useful, as you will then only need
to download the full version once, and will then be able to download the installer version for each new version. To

keep it simple, if you are confused about which version to download, use the installer version.

Both versions are available in multiple formats to suit different needs. If you are unsure of which version to

download use the .zip format.

Note: If you are a developer and are familiar with SVN you can also checkout the newest version of Magento

using SVN. To view the most up to date command please visit magentocommerce.com/svn.

If you have successfully downloaded Magento you are now ready to install the software on your web server.

Installing and Configuring Magento

Downloader Install

This section covers the installer installation process for Magento. If you have downloaded the installer package

from magentocommerce.com, then follow this guide to complete the installation.

Installation

1. Download the .zip or .tar.gz installer package from the Magento website and decompress it.
2. Upload all the decompressed files to your web server via FTP
3. Create a MySQL database and user/password for Magento

A This step varies by hosting provider and is out of the scope of this document. Consulty our pr ovi der 6s

support/documentation for instructions on how to do this.

4. The top-level Magento directory (the one you uploaded the decompressed files to) must have the correct

permissions in order for the installer to proceed. To do so, navigate to the directory with your FTP client. Then

|l ocate the function AChange P e FiiRckestand sefed it. Once youdihdaheg e Mo d e 0



function, you must set the permissions so the web server can write to this file. There are two typical ways of

representing file permissions in Linux:

A As a number (eg, 755)

A As a series of permissions categorized into user, group, and other

If your FTP client uses the first representation, set the permissions on the directory to be 777, or 0777. If your

FTP client uses the second representation, set the permissions as shown in the image below.

[ | Chmod (=

You can now adjust the attributes of your file(s)
Mote: Not all ftp servers support the chmod feature

rSpecial User | rGroup- Other-
[ ! suID ¥ Read v Read v Read
[ ] sGID ¥ Write ¥ Write vl Write

[ ] Sticky| ¥ Execute| ¥ Execute | Execute

| XEanceI|

5. If your server primarily runs PHP4 then you will require the PHP5 CGI Binary in order to continue. Please read

the PHP5 CGI Setup appendix below and complete it before continuing to Step 6.

6. Now use your web browser to surf to the Magento install:é

http://www.example.com/magento/, then the wizard will be located here: http://www.example.com/magento/.

7. Since you are using the installer version, the downloader will be the first installation process to run. It will

attempt to download all the necessary components for a comy
messages zip by onthe green-on-b | ack screen, dondt worry t detectemweetall about it
success or failure, and if you see the AContinue Magento |1
mi nutes) then the process has succeeded. Click the AConti nt

regular installer wizard.

8. Once in the wizard, you can configure various system-level settings that are required for Magento to function.
Most options wil/l be intelligently guessed for you, but yol
theveryleast , change the database parameters in the first box,

database you set up in Step 3.

P

9. Success! Youbve completed a Magento installation. You ¢

configuring your new online store.


http://www.example.com/magento/
http://www.example.com/magento/
http://www.magentocommerce.com/wiki/_detail/general/777_file_permissions.jpg?id=welcome_to_the_magento_user_s_guide:chapter_2&cache=cache

Default Install

This section covers the default installation process for Magento. If you have downloaded one of the standard

release distributions from magentocommerce.com, follow this guide to complete the installation.

Installation

1. Download the .zip or .tar.gz file from the Magento website and decompress it.
2. Upload the Magento web files to your web server via FTP
3. Create a MySQL database and user/password for Magento

A This step varies by hosting provider and isoutofthes cope of this document. Consult y

support/documentation for instructions on how to do this.

4. Ensure that the directories app/etc , var , and media are writable by the web server. To do so, navigate to
the directory with your FTP client. Then | ocat e the function fAChange PE&TPMi ssi onsc
client and select it. Once you find the function, you must set the permissions so the web server can write to this

file. There are two typical ways of representing file permissions in Linux:

A As anumber (eg, 755)

A As a series of permissions categorized into user, group, and other

If your FTP client uses the first representation, set the permissions on each directory to be 777, or 0777. If your

FTP client uses the second representation, set the permissions as shown in the image below.

[ | Chmod o X

You can now adjust the attributes of your file(s)
MNote: Not all ftp servers support the chmod feature

rSpecial User | rGroup- Other-
[l suiD | |l Read ¥ Read ¥ Read
L] sSGID | |V write || Write v Write

L Sticky| | Execute| ¥ Execute | Execute

| xgancel|

5. If your server primarily runs PHP4 then you will require the PHP5 CGI Binary in order to continue. Please read

the PHP5 CGI Setup appendix below and complete it before continuing to Step 6.


http://www.magentocommerce.com/wiki/_detail/general/777_file_permissions.jpg?id=welcome_to_the_magento_user_s_guide:chapter_2&cache=cache

6 . Now use your web browser to surf to the Magento install

http://www.example.com/magento/, then the wizard will be located here: http://www.example.com/magento/.

7. Once in the wizard, you can configure various system-level settings that are required for Magento to function.
Most options wil | be intelligently guessed for you, but youdre freece
the very | east, change the database parameters in the first

database you set up in Step 3.

8.Success! Youdbve completed a Magento installation. You can nov

configuring your new online store.

Appendix: PHP5 CGI Setup
Introduction

Some hosting providers do not yet provide PHP5 on their servers, opting instead to stay with PHP4 for the time
being. As Magento is a PHP5-only application, this can be a barrier for some users. This document outlines a
possible workaround for such a scenario. The goal is to install PHP5 as a CGI binary and configure the web

server (Apache) to use it instead of the default PHP4.

Requirements

Every hosting provider has a slightly different walk of doir
with your provider before continuing. Below is a list of the basic requirements that this document requires. If

youbre unsure as to whether your provider supports these 1 ¢

A Operating System: Linux

A Web Server: Apache with CGI support

A Filelnfo override control via .htaccess files

A A user-writable cgi-bin directory

A FTP access to your web root and cgi-bin directories

Step 1: Upload the PHP5 CGI binary

I't i s possible to compile a PHP5 binary yourself, but for t

You can download it here: http://www.magentocommerce.com/support/php5cgi/php5-cqgi

Once downloaded, use your FTP client to upload the file to your cgi -bin di rect or y. I f you donét ki

cgi - bin directory is, ask your hosting provider.

After uploading, use your FTP client to set the proper mode on the php5 - cgi file. This function varies for each

FTPcl i ent, but it wuswually called fAiChange Permissionso or AC|


http://www.example.com/magento/
http://www.example.com/magento/
http://www.magentocommerce.com/support/php5cgi/php5-cgi

you must set the permissions so the web server can run this file. There are two typical ways of representing file

permissions in Linux:

1. Asanumber (eg, 755)

2. As a series of permissions categorized into user, group, and other

If your FTP client uses the first representation, set the permission on the php5- cgi binary to be 755, or 0755. If

your FTP client uses the second representation, set the permissions as shown in the image below.

;| Chmod (=

You can now adjust the attributes of your file(s)
Mote: Not all ftp servers support the chmod feature

rSpecial User | r'Group Other
[ ! suID ¥ Read v Read v Read

[ ] sGID v Write [ | Write [ write

&grz | XQancel|

Step 2: Modify the Magento .htaccess file

By default, the web server will want to run the Magento application using PHP4, which will not work. In order to

point it to the new PHP5 CGI binary, you must modify the .htaccess file in the Magento top-level directory.
Using your FTP client, edit the file .htaccess in your top-level magento directory.

The file is somewhat | ong so we wonot Ilist it all here. But

#2 uncomment these Tines for CGI mode
## make sure to specifty the correct ggi. php binary Tile name

#2 1f might be /coi-bin/php-col

= Action phps-cgi /ogi-bin/phps-cgi
# addiandler phps-cgi . php
# php Flasa fai.Flx nathinfe on

First, remove the # symbol from the beginning of the last three lines listed in the excerpt above. This will enable

the special CGlhandl er for your Magento site. N Actidn, lingto poditd want t o


http://www.magentocommerce.com/wiki/_detail/general/755_file_permissions.jpg?id=welcome_to_the_magento_user_s_guide:chapter_2&cache=cache
http://www.magentocommerce.com/wiki/_detail/general/cgi_htaccess_file.jpg?id=welcome_to_the_magento_user_s_guide:chapter_2&cache=cache

the location of the php5- cgi binary you uploaded in Step 1. This path should be relative to the web root of your

site.

That 6s it! You can now proceed with the rest of the Magent

Troubleshooting
I stil |l see Al nvalid PHP versiono w

This probably means that your hosting provider does not allow the Filelnfo  overrides via .htaccess files. This

is a necessary requirement for this solution, so youdll h a\

I see Al nternal Server Erroro when

This is a typical error message when a CGl binary quits unexpectedly, and could be caused by a number of
things. I f you have access to your server 0sWeAddc hceo veerrr aar flec

more common issues here.

1. Bad location to the PHP5 binary. Make sure the AddHandler directive in your .htaccess file is
pointing to the correct location for the PHP5 binary. You can often test it by trying to surf to the

location with your web browser. For example, if your site is www.example.com and your PHP5

location is /cgi - bin/php5 - cgi , try visiting http://www.example.com/cqi-bin/php5-cdi with your

web browser. | f you Esreeradn nielsnstaegren alt hSenr vtehrat means vy«

the correct |l ocation. I f you get a AFile not foundo n
2. Bad permissions on the PHP5 binary.  Double check the permissions on the PHP5 CGI binary you

uploaded in Step 1. They should be 755 o rrwxii-xr-x0 , d e p e n diFiRc loine nytodusr

representation.

Configuration during Installation

Once you select your option you will see the files downloaded. The time required to download the files will depend
on your connection speed. Once the files have downloaded a success message will be displayed. Select OK and
you will be taken to the next step of the installation where you will set the default configuration settings for your

store.

The first settings you will need to enter will be your Database Connection settings. Your host will likely be your
domain name, the database name, user name and user password will be the values you created when creating

the database.
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Troubleshooting Installation

If you have difficulty with installation you can receive help at the www.magentocommerce.com site in the forums.

Introduction to the Administrative Panel

Once you have completed the installation you will be taken to the frontend of your site. To access the
administration panel you will add /admin to the end of the base url you specified during the installation. E.G. if you

specified example.com as the base url, just go to http://www.example.com/admin. Once you are at the login

section you will need to sign in using the user name and password you created during the installation process.

Select the Login button and you are now in the administration panel.

The following sections detail some of the most important features which you will want to address in the initial
configuration of your admin. Other features, such as adding products, payment methods, and shipping settings,

will be addressed in following chapters.

Creating Multiple Websites and Stores

If you are interested in creating a multiple Website, Store, and/or Store View setup you can do so by navigating to

System > Manage Stores.

Website

To create a new Website, click Create Website in the upper right corner.

Websites will each need to have a unique Code. This code can be a text name, but cannot have spaces or

special characters within it.

I f your Website name is New Website, a good rule of thumb

website code.

You can designate the Sort order of the Website as it will appear relative to your other Website(s) throughout the

admin.

If you have not indicated which Website will be displayed when the index.php path is requested by the browser,
your customers will automatically be directed to the default Website, which you select by checking the Set as

default checkbox.

Store

!
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To create a new Store, click Create Store in the upper right corner.
Select the Website to which this Store will be associated.

Select the Root Category which will be associated to this store. In your categories setup, you can create multiple
Root Categories, each associated to different Stores. The sub-categories and products associated to those
categories will only display in the Store to which the Root Category is associated. If you do not want to create
different Root Categories to display in different Stores, you can select the same Root Category for all Stores.

Categories are discussed in more detail in the next chapter.

Store View

As explained in Chapter 1, Store Views are best used to display a Store in multiple languages.
To create a new Store View, click Create Store View in the upper right corner.

Select the Store to which this Store View will be associated. The Code and Sort order fields work like those for

Websites.

For a Store View to be visible on the front-end, it must be Enabled . You can remove it from the front-end without

deleting it by selecting Disabled .

You can set unique Locales for each Store View. Simply navigate to System > Configuration, and select the
General tab from the left column. In the Current Configuration Scope drop-down above, select the desired
Store View. Uncheck the Use website checkbox next the Locale settings, and select the Locale you prefer. This

Locale will only apply to this Store View.

Permissions

Magent o6s Per mi sathiflexible andiptutivel. ¥ou dars crebte predefined Roles, which have
specific access to various parts of the admin. Then, you can create users and select which Role each user will

possess. You can associate Users to Roles in both the Users page and the Roles page.

Creating Roles

To create a Role, navigate to System > Permissions > Roles and click Add New Role .

Role Info

Enter the Role Name.

Role Resources
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Choose the Resources, or admin features, to which Users associated to this Role will have access. If you select
all from the Resource Access drop-down, this Role will have access to all resources. If you select Custom , a
resource tree will populate, and you will have to select the checkbox for each resource to which this Role will have

access.

Click Save Role.

Role Users

Once a Role has been saved, this tab will appear. It will display all Users that are associated to this Role. To see
a list of all Users, click Reset Filter . Click the checkbox of all Users you want to associate to this Role, and click

Save Role again.

Assigning Users

To create a User, navigate to System > Permissions > Users and click Add New User .

User Info

Enter all the information for this User. The User Name and Password will be used by this User to log into the
Magento admin panel. For a User to be able to access the admin panel, the User must be Active . You can

prevent a User from accessing the admin panel without deleting their User account by changing this to Inactive .

User Role

Select the Role to which this User will be associated. This page will produce a list of all existing Roles, and you

will only be allowed to choose one.

Click Save User.

Cache Management

Cache management can be accessed by navigating to System > Cache management. It can be enabled to
improve the performance of Magento. When developing on Magento it is best to disable the cache management.
You can enable caching on the entire site, or enable cache management on certain elements of the site by using

the various checkboxes in this page.



Chapter 3: Set Up Your Catalog

Overview of Catalog Concepts

Now that you have your store installed and your initial configuration settings
established, i1tés time to set up the heart
the most important part of any eCommerce site, and with Magento, you will have

complete control over it. So take advantage of this great opportunity!

Creating and Managing Categories

Setting Up Defaults

The first step to creating your catalog is to configure the catalog system settings.
To do this, navigate to System > Configuration, and select the Catalog tab.

Frontend

This determines how your products will be shown inthe front-e nd 6s cat al og
pages.

A Products per Page - Choose whether the category pages will display 9, 15, or
30 products by default. Your customers will be able to change this, or to
display All products.
A List Mode
A Grid Only - The products will display in a grid structure and your customers
will not have the option to change this.

A List Only - The products will display in a list structure and your customers
will not have the option to change this.

A Grid (Default)/List - The products will display in a grid structure by default
but your customers will be able to switch to list.

A List (Default)/Grid - The products will display in a list structure by default
but your customers will be able to switch to grid.

Product Options



A Default Tax Class - Select whether the default tax class for with new products
added to your catalog will be Taxable Goods or not.

Product Alerts

There are two types of product alerts to which you can allow your customers to
subscribe via email. Each have their own enable drop-down, and Email Template,
but they share the same Email Sender. For more information on how to configure
email templates and email sender addresses, refer to Chapter 6: Customers. The
Price Alert will create a link in every product page called Sign up for price alert
Clicking this link will subscribe your customer to this alert, and they will receive an
email when the product price is changed. This includes adding or changing
Special Prices in addition to the regular Price field. The Stock Alert will create a
link in every Out of Stock product called Sign up to get notified when this

product is back in stock . Clicking this link will subscribe your customer to this
alert, and they will receive an email when the product status changes to In Stock.
For each product, there is a tab listing all customers subscribed to either of these
alerts. There is more information about this in the Products section later in this

chapter.
Product Alerts Run Settings

This determines the frequency with which Magento checks both product prices
and stock status for changes, so that your subscribed customers can be alerted.

A Frequency - Designate whether you want Magento to check for updates Dalily,
Weekly, or Monthly.

A Start Time - Select the time of day (in 24 hour mode) at which you wish
Magento to check for updates.

A Error Email Recipient - Enter the email address to which emails will be sent
in case an error occurs during the check for updates.

A Error Email Sender - Select the address from which the error notification
email will be sent.

A Error Email Template - Select the template which the error notification email
will use.

Product Image Placeholders

This is discussed in more detalil later in this chapter, under Products.
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Recently Viewed/Compared Products

This is discussed in more detail in Chapter 5: Promotions, Marketing and Content
Pages, under Customer Personalization.

Price

You can determine the level at which prices are shared in the Catalog Price
Scope drop-down. If you select Global , prices will be shared across all websites.
If you select Website , prices can differ between websites, although they will still
be shared between store views contained in the same website. The price here
affects several different areas in Magento. For example, this includes product
prices, base currency, price filters in the admin, and catalog/shopping cart price
rules.

Search Engine Optimizatons

Configure these options to make your site more Search Engine Friendly.

A Autogenerated site map - If you Enable this feature, a Site Map link will
display in the footer on the front-end, directing to an automatically generated
site map including a list of all of your existing categories. In addition to the
Autogenerated site map, Magento allows for integration with Google Sitemap.
There is more information about this below.

A Popular search terms - If you Enable this feature, a Search Terms link will
display in the footer on the front-end, directing to list of all search terms,
displayed as a cloud. This is an SEO feature because each of these search
terms counts as a link to your site, and is registered by search engines.

Popular Search Terms

a bambo0 barcelona bed blue colorful COO| discount

UDQ NOUSE fumiture green laptop mac machook
magent@ new notebook cakwood pe red rolex FOSE

television  test tU“DS watch
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A

Page Title Separator - Enter a character in this field, and it will be placed
between the various Meta Information in the Page Title, that displays at the top
of the browser.

Use categories path for product URLs - This determines how the URL
Rewrites autogenerate. If you choose Yes, the URL rewrite for products will
include the associated category, and a separate rewrite will generate for each
associated category. If you choose No, the URL Rewrites will include only the
product name, and there will be only one rewrite, regardless of how many
categories the product is associated to.

Product URL Suffix (cache refresh needed) - This also affects how the URL
rewrites autogenerate. The value entered into this field, for example .html, will
automatically be added to the end of your URL rewrite generated for products.
There is more about this topic in the section about URL Rewrites.

If you want to configure Magento integration of Google Sitemap, navigate to
System > Configuration and select Google Sitemap from the left column.

Categories/Products/CMS Pages Options

The sitemap settings for each of these three types of pages can be configured
individually.

A

Frequency - Designate how often you would like Google Sitemap to check
each type of page for updates.

Priority - Designate the priority that each page type receives in relation to the
other page types when Google Sitemap updates.

Generation Settings

A

Enabled - Select Yes to Enable Google Sitemap autogeneration and
automatic updates.

Start Time - Select the time of day (in 24 hour mode) at which you wish
Google Sitemap to update.

Frequency - Designate whether you want Google Sitemap to update Daily,
Weekly, or Monthly. This can differ from the frequency that Google Sitemap
actually checks for updates (as defined above).

Error Email Recipient - Enter the email address to which emails will be sent
in case an error occurs during the automatic update.
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A Error Email Sender - Select the address from which the error notification
email will be sent. For more information on how to configure these email
addresses, refer to Chapter 6: Customers.

A Error Email Template - Select the template which the error notification email
will use. For more information on how to configure these templates, refer to
Chapter 6: Customers.

Creating Categories

To create and edit categories, navigate to Catalog > Manage Categories. In the
center of the page you will have the option to create a new category.

1. Enter a name for the category. This is how it will appear on the front
end of the sites selected.

2. Select the location in which the category will be created from the
Parent Category drop-down. The default is Root, and any category
created with this as its parent will be a Root Catalog level category
(although the name of that category does not need to be Root Catalog).
Having multiple Root Catalog level categories is useful if you want to
use different category structures in different Stores. If you are not using
a multiple Store structure, multiple Root Catalogs are unnecessary.
Refer back to Chapter 2 for more information about Stores and
assigning Root Catalogs. Any category created with a Root Catalog
level category as its parent category will be a top-level category in the
navigation bar on the front end. If you wish, you can allow customers to
subscribe to a list of all your top-level categories via RSS feeds. There
is more information about RSS Feeds in Chapter 5: Promotions,
Marketing, and Content Pages. If an existing top-level category (i.e. not
the Root Catalog) is selected as the parent category, the new category
will be created as a sub-category of the selected top-level category,
and will appear on the front-end in a drop-down menu when the top-
level category is rolled over. If a category is created within a second-
level category, the category menu will further expand, to the right, when
the second-level category is rolled over, and so on.
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Furniture  Electronics

Additionally, when a customer is browsing through your site, the

category levels will display at the top of the page, below the navigation

bar, in a Abreadcrumbo. llFaverthe x ampl e, [
navigation bar, arrives at Apparel > Shoes > Mens and clicks Mens,

they will be directed to the Mens category page. The breadcrumb will

Furniture  Electronics

Home [ Apparel §f Shoes P Mens
look like: The current page will be

in plain text, and all the parent categories will be links to the
corresponding category pages. The same is true of product pages. In
this case, the product name will be last in the breadcrumb, in plain text,
and all categories will be linked. This is a dynamic feature, so that the
breadcrumb will display the category pages according to the path by
which your customer navigated to the product. If you have a product
associated to multiple categories, the breadcrumb will detail only the
specific path your customer chooses each time they arrive a product
page. The breadcrumb improves usability by allowing customers to
keep track of their location within your site at all times, with a clear path
for how to return to previous pages.

. Enter a Description . This is for internal use only, and will not appear
on the front end.

. Select an Image by clicking the Browse... button and locating the
image on your computer. This image will appear on the front end of
each categoryb6s page between the catec
category has been saved with an image, a small icon of the existing
image will appear to the left of the Browse... button, and a Delete
Image checkbox will appear to the right.

. Enter the meta information for the category in the Page Title , Meta
Keywords , and Meta Description fields.

. Display Mode and CMS Block refer to using static blocks with
categories. For more information about this, refer to the Using static
blocks with categories section below.
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7. Select Yes or No from the Is Anchor drop-down. This drop-down has
two effects.

A Anchored categories will display all products associated to all
child categories (and child of child, and child of child of child,
etc.) on that categorybs page, al or
directly to the parent category.

A Anchored categories will display the filterable attributes of all
products that display in the category page (meaning the
products associated to that category and to its child categories)
in the Layered Navigation menu in the left column. Layered
Navigation is discussed in more detall |later in the chapter.

8. Select Yes or No from the Is Active drop-down. Select Yes for this
category to be visible on the front end. If you select No, the category
cannot be accessed from the navigation bar on the front end, nor can
any of its sub-categories, and the category name will display as light
gray in the category tree in the left column of the categories page in the
admin.

9. The URL key adds a relative URL path which can be entered in place
of the standard Target Path. It is Search Engine Friendly because it can
use the name of the category instead of the ID#. For more information
about URL Keys, refer to the section about URL Rewrites. If you leave
this field blank, it will automatically generate with the name of the
category upon creation of the category. If you enter a value here
manually, you cannot use spaces in this field.

In the left column will be a drop-down menu called Choose Store View . The

default selection in the menu is All Store Views . When this is selected, you will
beabletoview t he Adefaulto options for each cat
store view, you will be able to see the options specific to that store view for each

category. Only certain options can vary between store views. Options that cannot

vary, and willbethes ame i n al | store Vviews, are cal l
label [Global] next to them. Those that can differ between Store Views will be

labeled [Store View] . Note: The products assigned to a category, accessed

through the Category Products tab, are not global. This way, you can choose to

have different products display in each store view.
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Below this drop-down is the category tree, which lists all existing categories and
displays their relationship to one another. For example, if one category is a sub-
category of another, it will be listed directly below it, and indented one level. Next
to each category name in the tree is a number inside parentheses. This number
represents the amount of products associated directly to that category. Because
the products are associated at the store level, the numbers in parentheses will
vary depending upon which store view is selected from the drop-down. To edit
any existing categories, select it from the category tree, and its options will appear
in the center of the page, replacing the New Category section. When editing a
category, the Parent Category drop-down will not be present. In order to move a
category to a different Parent Category, simply drag and drop it directly in the
category tree.

To return to the new category view, simply select a category from the tree and
click the Add New button. This will automatically assign the selected category as
the parent category in the drop-down.
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Assigning products at the category level

Products can be added to a category while the category is being created, or
anytime thereafter. Simply select the desired category, and access the Category
Products tab (from the top of the category page). You will notice that the leftmost
column in the grid contains a drop-down menu. The default selection will be Yes,
meaning that the grid will only display items already associated to the category.
Therefore, a brand new category will always have a blank product grid. In order to
search for existing products to associate to this category, select either No (which
will only display products that are not associated to the category) or Any (which
will display associated and unassociated products) from the drop-down, and click
the Search button. You can narrow your results further by using the ID, Name,
SKU, Price, or Position filters (although the position filter only works for products
already associated to the category). Select the checkboxes of all products that
you wish to associate the category, and unselect all checkboxes of products you
wish to deassociate. After a product is checked the Position field will become

active and youodl | be able to enter a sort
the products display on the front end, regardless of the order in this grid.
Call Phenes = et | Sam Cafegory
Cenernl nfarmation Cadigary Froducls Custom Dasign
Pags# 1 of 1 pages | View X ﬂ perpage | Tolsl S récands found nse Fillog I"’.""l': i
= W ¢ Hame SHU Price Puesition
ves =) From: From:
To: To:
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Assigning designs at the category level

You can customize the design of each category individually in the Custom Design
tab. This controls the look of the category page, including the objects on the page
and the structure of the page.

1. Select the design you want from the Custom Design drop-down.
Magento comes with several different design options out of the box, but
you can add your own by... If you leave this drop-down blank, it will
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automatically use the Current package name design. This can be
edited by navigating to System > Configuration and clicking the Design
tab. Enter the name of the design you want in the Current package
name field, and this design will apply to all categories for which you do
not specify a different design.

. Select your preference from the Apply To drop-down. This category
only means that the design will only apply to this one category page.
This category and its products  means that the design will apply on
this category page, and on the pages of all products associated to this
category. If a product is associated to multiple categories, each with a
different design, the design displayed on that product page will be
determined by the design of the category page from which the user
navigates to that product. This category and its child categories

means that the design will apply on this category page, and on the
pages of all sub-categories, sub-sub-categories, and so on. If a child
category has a different design selected than its parent category,
then... All mean thats the design will apply to this category, its child
categories, and its products.

. With the Active From and Active To fields, you can select a time
frame in which the category will automatically switch to a design, and
then switch back to the blank option when the time frame ends. This is
perfect for the holidays, so that you can create a holiday design for you
pages, and then have your site automatically switch back to the normal
design whenever you want, without having to remember to do it
yourself.

. The Page Layout drop-down determines the structural aspects of the
page. No layout updates uses the default settings that come with the
Magento installation. Empty displays the category page without any
objects, except for the content (products or static blocks only), category
name, and view options (number to display per page, view as grid or
list, and sort be options). 1 column displays the contents, category
name and view options, as well as the header, footer, search field, and
navigation bar. Column on the left adds the left column to the 1
column display, which by default includes the currency selection and
layered navigation. Column on the right adds the right column to the 1
column display, which by default includes the shopping cart view,



5.

wishlist, compared products list, polls, and newsletter sign-up. 3
columns displays both the left and the right column.
The Custom Layout Update is essentially a static block, with a few
differences.
A Rather than HTML, the structure must be in XML format.
A The Update will display at the bottom of the page, below the
products, whereas a static block will display above the products
(if the static block is set to display with products)
A The Update will display on the page only during the dates
specified in the Active date range.

Using static blocks with categories

If you would like customers to be taken to a landing page when they select the
category, instead of the standard product listing page, you can do so by enabling
static blocks on your category page. This is controlled the in General Information

tab.

1.

In the Display Mode drop-down, select what content you want to
display in your category page. Products only means that the products
associated to the category will display, but not any static blocks. Static
block only means that the selected static block will display, but none of
the products. This is ideal if you want to get your customers excited
about the category before showing them products or if there is specific
content you want to show for a certain category (tip: Make this page an
anchor category and let your customers use layered navigation to find
their products after viewing the landing page). Static block and
products means that the static block will display with the products
listed directly beneath it. This is useful if you want to have several
category pages where the same static block content is needed, but
each feature different products.

. In the CMS Block drop-down, select which static block you would like to

display on your category page. It will include all existing static blocks,
which can be created in the static block manager by navigating to CMS
> Static Blocks. For more information about creating static blocks,
please read the section about them in Chapter 5: Promotions,
Marketing, and Content Pages.
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Attributes

Creating an Attribute

In Magento, Attributes are quantifiable or descriptive aspects of a product, from
the color, to the manufacturer, to the SKU number. There are two kinds of
attributes in Magento: Simple Attributes and System Attributes. By default,
Magento includes all the necessary System Attributes. These cannot be deleted,
and every product must have each of these attributes. Therefore, all Attribute
Sets must include these products (more on Attribute sets in the next section).
These type of attributes include Name, Price, and SKU, without which a product
would not function. Simple Attributes, on the other hand, are attributes created by
the Store Owner. These will likely be more specific for individual products, and
therefore will not necessarily be included in every Attribute set. For example, if
you were to create an attribute for color, with values of blue, green, yellow, etc.,
you may want to apply this attribute to an Attribute Set for shirts, which you sell in
various colors, but you probably would not include it in an Attribute Set for DVDs,
for which color is not really an applicable attribute. To create a Simple Attribute,
navigate to Catalog > Attributes > Manage Attributes, and click Add New
Attribute in the top right of the page.

Properties
Attribute Properties

A Attribute Identifier - This is the name of the attribute used by the system. It
will appear in the Attributes list in the Attribute Code column, and it will be
used when managing Attribute Sets, however it will not appear on the Front-
end. Each attribute you create must have a unique Attribute Identifier, and this
value cannot contain spaces.

A Scope - This drop-down determines the level at which the values of this
attribute are shared. When creating a product, you will be able to see the
Scope to the right of each attribute. You can choose to make any attribute
shared Globally, at the Website Level, or at the Store View Level. Global
means that the value of this attribute for a given product must be the same
throughout your site. Website means that the value of this attribute for a given
product can differ in different Websites, however it cannot differ between Store
Views contained under the same Website. Store View means the value of this
attribute for a given product can differ in all Websites and all Store Views. For



example, if you were creating an attribute called Color, with a Store View
Scope, you would be able to set the color of a product to green in one Store
View, and blue in another Store View.

Catalog Input Type for Store Owner - This describes what kind of data the
attribute will store. Whatodos set here det
will take place. For example, a Description attribute would use a text field, so
that you can manually enter a description for each product, whereas a Color
attribute would use a drop-down, so that you choose the color of each product
from a drop-down list (the values of which you will enter in the Manage Label /
Options tab).

Default Value - If you choose to enter a Default Value, each new product
created with this attribute will automatically have this attribute prepopulated
with the value you enter here. However, you will always be able to edit the
prepopulated value. This field will not display if you have selected Multiple
Select, Dropdown, or Media Image as your Input Type. If you have a
Dropdown or Multiple Select Input Type, you will be able select the Default
Value in the Manage Label / Options tab.

Unique Value - If you designate an attribute to be a Unique Value, that means
the value selected or entered for this attribute for each product must be
different. If Color was a unique value, only one product could be green, one be
blue, etc.

Values Required - If you require values, you must select a value for this
attribute for each product you create. You will not be able to save a product if
this attribute is left blank.

Input Validation for Store Owner - This controls the type of check Magento
places on the values entered for this attribute for each product. If you select
None, you can enter any type of information as the value for this attribute. If
you select Email, for example, Magento will make sure that the value entered
for each product resembles an email address. If it does not, you will receive a
warning message.

Apply To - Decide which Product Types will include this attribute. The three
Product Types in Magento are Simple, Grouped, and Configurable Products
(there is more information on the differences between these Product Types in
the Products section later in this chapter). If you select Selected Product
Types, a multiple select menu will appear where you can choose to which of
the Products Types this attribute will be associated.

Use To Create Configurable Product - This drop-down will only appear if the
Scope is Global and the Input Type is Dropdown. If you select Yes, this
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attribute will be a Configurable Attribute. When creating a Configurable
Product, the next step after selecting the Attribute Set and Product Type is to
select the Configurable Attributes for this product. You will see a list of all the
existing Configurable Attributes associated to the Attribute Set. If you select
the checkbox, this attribute will be a Configurable Attribute for this product. If
you leave the checkbox empty, this attribute (while still a Configurable
Attribute in your attribute settings) will not be a Configurable Attribute for this
product. If an attribute is a Configurable Attribute, this means that the
customer will be able to select the value of the attribute from a drop-down in
the front-end. It is customer configurable. For more information about
Configurable Products, please refer to the Products section later in this
chapter. Note: This drop-down is not related to the Apply To menu above. An
attribute can be a Configurable Attribute even if it is not applied to
Configurable Products. If this is the case, you will be able to select the
attribute as a Configurable Product when creating a product, but you will not
be able to see this attribute among the p
Product page.

Frontend Properties

A Use in quick search - If you select Yes, Magento will search all the product
values for this attribute when your customer uses the search bar in the header.
If you select to use Color in the quick search, your customers will be able to
type in green or blue and find products that match that color. For more details,
see Chapter 5: Promotions, Marketing and Content Pages.

A Use in adva nced search - This is very similar to the quick search. However,
in the Advanced Search, each attribute will have its own field, rather than there
being one search field. If you select Yes, a field will be created for this attribute
in the Advanced Search page. For more details, see Chapter 5.

A Comparable on Front -end - If you select Yes, a row will be created for this
attribute in the Compare Products pop-up window. For more details, see

Chapter 5.

A Use in Layered Navigaton -Magent o6s Layered Navigati ol
customers to filter down into a categorybd
Afilterableo for Layered Navigation. The

in the left column of your category pages, and will contain all of the attributes
which are filterable. Under each attribute will display the various values of that
attribute. Clicking one of these values will filter the list of products in that
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category page so that only products matching that attribute value will display.

There are two types of filterable attributes, which you can select from this

drop-down: Filterable (with results) and Filterable (no results) . This

determines which values will display in the Layered Navigation menu. If you

select Filterable (with results), only values that correspond to products in that

category page will display in the menu (that is, only values that produce
Aresultso when used as a f idults)eatlvyaluesl f you
that youbve created in the Manage Label [/
they correspond to any particular products in that category page (it includes

values that do not produce firesultsd when
filterable attributes in a particular category page, the Layered Navigation menu

will not display. In order to make an attribute filterable, the Input Type must be

either Dropdown, Multiple Select, or Price.

A Position - This determines the position of the attribute in the Layered

Navigation menu with respect to the other filterable attributes.

A Visible on Catalog Pages on Front -end - This field only appears for Simple

Attributes. On the product page in the front-end, there is a section called

Additional Information, that displays below the Product Description section.

The attribute name and value for all/l Avis
this section. If a product does not have any visible Simple Attributes (or if the

product does not have any values selected for its Simple Attributes) there will

be no Additional Information section on the front-end.
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Manage Label / Options

A Manage Titles - In the Admin field, you must enter the name of the attribute

as it will appear in the admin. For each Store View, you can specify a different
name for this attribute. This is useful if you manage multiple Store Views with
different languages. For example, in the Admin field, type Color; in the UK
Store View field, type Colour; in the French Store View field, type Couleur. If
you leave the field blank for any of the Store Views, the Admin Label will be
used.

Manage Options - This section will only appear if the Input Type is Dropdown
or Multiple Select. In order to have a drop-down or multiple select menu in the
product page, you must have predetermined values to populate these menus.
This is where the values for these menus are predetermined. This works very
similar to the Manage Titles section above. For each value you wish to create,
click Add Option . You can enter an unlimited number of values. For each
value, you must enter a name in the Admin field, and you have the option to
enter a different name for each Store view. For example, create two options.
For the first option, enter Green in the Admin field; leave the UK Store View
field blank, because it uses the same name; enter Vert in the French Store
View field. For the second option, enter Blue in the Admin field; leave the UK
Store View field blank; enter Bleu in the French Store View field. You will also
have the option to select the position and which value(s) is the default. Enter a
numerical value in the Position field, and this will determine the sort order of
the values in the drop-down/multiple select menu relative to each other. For
the Dropdown Input Type, you will have an Is Default radio button with which
you can select one value. For the Multiple Select Input Type, you will have an
Is Default checkbox with which you can select multiple values.
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Managing Attribute Sets

An Attribute Set is a collection of attributes, customized to fit certain types of
products. Al Attribute Sets must contain
you can customize them to include different combinations of Simple Attributes.

For example, if you sell several different kinds of T-shirts in your site, you would

want to cgleiarttes@a AtTtri bute Set, which incl
commonly shared by all of your T-shirts. This may include color, size, gender, and

brand. Once you have created each of these Simple Attributes (refer back to the

previous section for more details), you can associate them to an Attribute Set. A

product is then associated to an Attribute Set during product creation, and the
Attribute Set 0 swill8ppeapn tlee Néw Produict page se that you

can set the various values.

Creating an Attribute Set

To create an Attribute Set, navigate to Catalog > Attributes > Manage Attribute
Sets and click Add New Set in the top right of the page. Before configuring the
Attribute Set, you must enter a name and import Attributes from an existing
Attribute Set. The Name will not be used anywhere on the front-end, and can be
edited at any point. Even if you have not created any Attribute Sets previously,
you can select the Default Attribute Set from the Based On drop-down, which
comes with Magento by default, from which you will import Attributes. This
includes all of the System Attributes, organized into Groups according to their
function. The Default attribute can be customized just as any Attribute Set that
you create. Once you have created additional Attribute Sets, you can choose any
of these from the Based On drop-down, which will import the Simple Attributes
and Groups from that Attribute Set, saving you time during the configuration
process. When you are finished, click Save Attribute Set . The Attribute Set will
be created, and you will be directed to the configuration section.

A Edit Set Name - This field will contain the name that you entered in the
previous step. It can be edited at any point during the configuration, or later on
by editing the Attribute Set.

A Groups - Groups are like folders which contain attributes. Each Group
corresponds to a different tab in the New Product page. This helps organize
the attributes by function so that you can edit them in the product page more
efficiently. Magento comes with five Groups by default: General, Prices, Meta



Information, Images, and Design. These contain the various System

@namm

Attributes, marked with a red circle = on the attribute icon. System
Attributes cannot be removed from an Attribute Set, however they can be
moved to different Groups. Therefore, you can remove a Group as long as
there are no System Attributes within it. The ordering of both the Groups and
the attributes can be changed by clicking and dragging it. This affects the
order of the tabs and attributes in the product page, respectively. You can also
create a new Group, to which you can move System Attributes, or associate
Simple Attributes. To do this, click Add New, and enter the name of the Group
in the pop-up.

Groups | Un

Diauble click on a group to rename it

=1 General N
E The page at https://var-dey.varien.com:444 83 ,lil

}_?) Flease enter a new group name
L]

| T-shirt Attributes

ok Cancel |

[ Iy ! W B

[ P _TFOTT_ et
£ g news_to_date
F ctatine

Unassigned Attributes - This list contains all of the Simple Attributes which
you have created. You can associate one of these attribute to your Attribute
Set by clicking and dragging this attribute into the desired Group. Once it is
associated to this Attribute Set, it will no longer appear in the Unassigned
Attributes list. To disassociate an attribute, click and drag it back to the
Unassigned Attributes list.
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When you are finished, click Save Attribute Set again to save the configurations.

Assigning Attribute Sets to Products

When creating a new product, you must
Navigate to Catalog > Manage Products and click Add Product in the top right of

¥ Mew Product

Create Product Settings

Attribute Set  Default Bd
Default

Froduct Type

the page.

Selecting the Attribute Set will load all of the corresponding Groups (tabs) and
attributes into the product creation page.

f

r
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Note: Once the Attribute Set has been selected, it cannot be changed. You can
change the attributes in a product by creating a new product and assigning a
different Attribute Set. You can also edit the Attribute Set, and add or remove
attributes, however this will affect all products associated to this Attribute Set.

Products

Before you begin to create the products that you will be offering in your webstore,

|l et 6s take a moment to explore the differe
and what these differences mean. In Magento, there are three product types that

you can create: Simple, Configurabl e, and Gr ouped. Let 6s begi
because this is the foundation for both Configurable and Grouped Products. A

Simple product is basically what its name indicates. It is the simplest type of

product to sell on your website; one individual product, where the attributes are

determined by the store owner. It will have system attributes (as all products

require), and can have simple attributes as well. One example of a Simple

Product would be a suit jacket. It is presented on your website as a standalone

item, and as the store owner, you define that it is black, with three buttons on the

front. When your customers arrive at the page for this product, they can see what

the color and button count are in the product information section, their only option

Is whether or not to buy this item.

A Configurable product, however, offers mu
stick with the example of the suit jacket, because, as a Simple Product, is the

foundation for a Configurable Product. In addition to this one suit jacket, you start

to carry slightly different versions of the same jacket: a navy blue version, as well
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as one with four buttons on the front (in black and navy). You create three new
Simple Products (navy/three buttons, black/four buttons, and navy/four buttons),
and if you only use the Simple Product feature, you would have four product
pages, one for each combination of color and buttons. Using Configurable
Products, however, you can combine all four pages into one, so that your
customer is guaranteed find the exact suit jacket they desire, while
simultaneously making navigating your site as easy as possible. Once you have
created the four Simple suit jackets, you can create a Configurable suit jacket,
and associated all four simple products to it. You will not set the color or button
count of the Configurable Product when you create it, but rather, your customer
will set this when they purchase it. It is a Configurable Product because your
customers get to configure the attributes themselves. So, you can choose not to
display any of the four Simple Products on you site, but rather only display the
one Configurable Product. When your customers arrive at this page, instead of
seeing the attributes listed in the product information section, they will see a drop-
down for color (with options for black or navy) and a drop-down for button count
(with options for three or four). The combination of attributes they choose
determine which of the four Simple Products they are actually purchasing. The
attributes point to the Simple Product, so that Magento knows which Simple
Product to place in the order. The Configurable Product is therefore not a product
at all, but rather a feature used to display multiple Simple Products on one
product page.

In this sense, a Grouped Product is very similar to a Configurable Product. It is
also only a feature used to display multiple Simple Products on one product page.

However, it displays them in a different

of the suit jacket. Forget about the three new versions that you began to carry,

and | etds go back to the classic bl ack

suit jacket, you also sell matching slacks and vest, the venerable three-piece suit.
Using Simple Products alone, you would have three separate pages, one for each
piece. But you feel that these should be sold together, because they are part of a
set. This can be easily accomplished using Grouped Products. Simply create a
Grouped Product i maybe you want to call it Three-Piece Suit 1 and associate all
three Simple Products to it. On your website, the page for this Grouped Product
will list all three Simple Products, each with its own quantity field. This way, your
customers are alerted of the presence of the set, and even encouraged to buy the
pieces together, however they still have the option to buy the pieces individually

f

wi t



(you can actually force them to buy all three pieces together, but we will get into
that later on).

Setting up configuration and Attributes

Now that you are ready to start creating products, make sure that you have
everything that you need set up. There is one configuration feature that needs
addressed. I f you havenét already done so,
and select the Catalog tab. In the Product Options box, select your Default Tax
Class. By default Magento comes with one option for this drop-down: Taxable
Goods . If you will be selling products on your site which will need to be taxed,
select this option. The Tax Class for all new products will automatically be set to
Taxable Goods, which will save you the time of having to manually change this
option for each new product. You can learn more about setting up the Tax Rates
and Tax Rules that apply to the Taxable Goods Tax Class, as well as creating
new Tax Classes in Chapter 4: Get Ready for Selling.

In addition to this configuration setting, make sure that you have created

Attributes and Attribute Sets, which you can apply to your new products. You

cannot change a productdés Attribute Set on
(although you can add Attributes to the Attribute Set and thereby add them to the

product), so make sure that you have the correct Attribute Set set up for your

product before creating your product. For more information about Attributes and

Attribute Sets, refer back to those sections in this chapter.

Creating a Simple Product

1. Navigate to Catalog > Manage Products.

2. In the top right corner, click Add Product .

3. Select an Attribute Set. Select Default i f you havendt creat
attribute sets. This will determine what product data you can enter. You
can refer back to the previous section for more information about
managing Attribute Sets.

4. Select Simple Product .

5. Press Continue .

6. Enter all product i nformation. Once yoc
taken to the productds data entry page
depending on your Attribute Set (you may get rid of weight but add
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General

megapixels, for example). If you realize that you want to add an
attribute to this product before creating it, there is short cut available.
Rather than having to go to the attributes page and create an attribute,
and then having to go to the Attribute Sets page and add that attribute
to the Set, you can simply click Create New Attribute in the product
page. This button exists in all five default Groups (tabs) and any
Groups which you have created. Note: Not all tabs correspond to
Groups. Groups are folders that exist in the Attribute Set. This opens a
pop-up window, which is identical to the New Attribute page. When you
enter the attribute information and click Save Attribute, the attribute will
be created, and automatically associated to the Attribute Set for the
product you are editing, into the Group in which you clicked the Create
New Attribute button. You will immediately see the new attribute at the
bottom of new product page. If you are managing multiple Websites or
Store Views, the attribute Scope will appear next to each attribute in the
new product page. This can be either [GLOBAL] , [WEBSITE], or
[STORE VIEW]. This refers to the level at which this attribute is shared.
For example, if the attribute Color had a [WEBSITE] Scope, you would
be able to set the color of a product to green in one website, and blue
in another website. However, within each website, all the different Store
Views would have to have the same color. The Scope can be defined
for each attribute. You can refer back to the section about Attributes for
more information on this configuration.



Marne * ‘Black Suit Jacket [STORE WIEWY]
Description ™ This jacket is sleek and simple, and will never | [STORE YIEW]

go out of style. Sewn from only the finest [talian

fahrics, it will lastyou a lifetime. A areat

accessany for the office, dinner with your

in-lamrs, ar just put it on when you are sitting an

the couch so that yau can feel impartant.
short Description * & stylish black jacket for any farmal oceasion. [ETORE YIEW]
Sk * black_jacket_t [GLOBAL]
Weight * 23 [GLOBAL]
Set Product a5 Mew fram | = MEBSITE]
Date '
SetProduct as Newto Date | = [WEBISITE]
Status * 'Enabled ¥ wEBSITE]
URL key | [GLOBAL]
Visihility *  Catalog, Search =] [=TORE ViEW]
Mllowy Gift Message ' Use config =] ieLosal

> >

>

Name - The product name as it will appear in the front-end

Description -The productodés description. I
the product page.

Short Description - Short description is specific to this design package. This

description will display at the top of the product page, and in category listings
in List view.

A SKU - The products SKU. Magento uses SKU as a unique identifier for this
product, across all stores and websites. SKU is global, meaning if you update
the SKU for a product in one store, it will update in all other stores as well.
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A Weight -The pr odu c-usualy useel forgshigping calculations
A Set Product as New from/to Date - In these fields, enter the date range in
which the product will be promoted as a new product. For more information
about this promotion feature, refer to Chapter 5: Promotions, Marketing and
Content Pages.
A Status - Two available-Enabl ed, Di sabled. AEnabl edo d
frontend, and ADi sabl edo dendsndt display in
A URL key - The Search Engine Friendly URL Identifier adds a relative URL
path which can be entered in place of the standard Target Path. It is Search
Engine Friendly because it can use the name of the product instead of the ID#.
For more information about URL Keys, refer to the section about URL
Rewrites. If you leave this field blank, it will automatically generate with the
name of the product upon creation of the product. If you enter a value here
manually, you cannot use spaces in this field.
A Visibility - You can decide whether your product will display in the page(s) of
its associated category(ies), display when your customer searches for the

product, both, or neither. 't may be usef
customers if they are associated to a Configurable or Grouped Product, so
that the product is only visible through

page, and not visible separately.

A Allow Gift Message - If you have enabled Product Level Gift Messages in the
Configuration page (for more about this, see Chapter 4: Get Ready for
Selling), you can allow your customer to enter a gift message for a specific
product during checkout by selecting Yes. If you select Use config, it will use
the value in the Allow Product Level Gift Messages  drop-down in the system
configuration. This differs from Order Level Gift Messages because your
customers can add a different message for each product that has this feature
enable. This is useful if they create one order, but ship to multiple addresses.

Prices
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Price * 29993 [WEBSITE]
usD]
Special Price [WEBSITE]
[usp]
Special Price From Date = [WWEBSITE]
Special Price To Date | [WEBSITE]
Cost [WEBSITE]
[usD]
Tax Class® Taxable Goods _:I [WEBSITE]
Tier Price Customer Group Oty Price Action

A Price - The price of your item as it will display in the front-end. If you have a
special or discount, this will be the original price.

A Special Price - You can enter a Special Price for this product. In the front-end,
this will appear underneath the original price (referred to as the Regular Price),
which will be crossed out. The Special Price will display in red, and be referred
to the Special Price. If you wish, you can allow customers to be alerted of new
specials via RSS feeds. There is more information about RSS Feeds in
Chapter 5: Promotions, Marketing, and Content Pages.

A Special Price From/To Date - You can enter a date range within which the
Special price will be active. This price will apply automatically when the From
Date arrives and deactivate automatically when the To Date arrives. If you
leave this range blank, the Special Price will apply until you remove it.

A Cost - The Cost is for internal purposes and does not require a value.

A Tax Class - This is the Product Tax Class to which this product will be
associated. This determines which Tax Rule will be used for this product, and
consequently the Tax Rate that will be charged to your customers. For more
information about taxes, refer to Chapter 4: Get Ready for Selling.

A Tier Price - Chapter 5 also provides more information about Tier Pricing.

Meta Information
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Meta Information

Mets Title EEIIau:k Suit Jacket [STORE WIEW]

heta Kewwards black, suitjacket, stlish, ltalian fabrics [STORE WIEW]

Meta Description A stylish black jacket for any formal occasian. [STORE WIEW] 4 maximum 255 chars
e e
Keywords and Meta Description can be entered for this product. The Page Title
will display in the browseros title bar

Keywords and Description will show in the tag of the produc t HBT8IL source.

Images

Inage tygen anal il of rmalion mned 1o o specifiod o osch stong wow,

-

Image Label Sort Ovdder Base Image Srmall Image Thumbmail Exchude Remaove
[STORE WIEW] [STORE WIEW] [STORE VIEW]
Mo image « r T
Juckat i & & &= r I

By default, Magento requires you to designate three image types: Thumbnail ,
Small, and Base. These images each correspond to different locations on the
front-end where they will display. When first creating a product, you will not have
any custom images uploaded. Therefore, all three image types will be set to No
image . This means that they will use your global Product Image Placeholders
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To configure these, navigate to System > Configuration, click the Catalog tab in
the left column, and upload a placeholder image for each image type. To add
custom images to a product, click Browse Files and locate the desired image. Do
this multiple times until you have selected all your desired images, then click
Upload Files . The images will list vertically in the image page. By default, all
images uploaded here will display under MORE VIEWS on the front-end. This is
located under the main product image, and clicking any of the images displayed
here will open a pop-up window with the ability to browse through all the images
associated to the product. For each image in the admin, you can add a Label,
which will display above the image in the pop-up window. You can add a Sort
Order, which will determine the order in which the images are displayed in the
MORE VIEWS section and the order in which they are browsed in the pop-up
window. You can designate which of these images is associated to which of the
three image types by selecting the radio button in the appropriate column (only
one image can be the Thumbnail image, only one can be the Small image, and
only one can be the Base image). The images will automatically resize to fit the
dimensions of each image type. The Base image, however, works a little bit
differently. This is the main image that displays prominently on the product page.
It will resize to fit the image window, however, if it is larger than the window, your
customers will be able to zoom in on the image, and then double-click the image
so that it displays the entire image outside of the original image window at the
designated zoom level. If you want and image to only associate to one of the
three image types, and not display in the MORE VIEWS section, you can check
the Exclude checkbox. To remove an image, check the Remove checkbox
before saving the changes.

In addition to these features, Magento allows you to add your own custom
watermarks to the images in your site, to hamper visitors from making unwanted
copies. If you would like to add watermarks, navigate to System > Configuration,
and click the Design tab in the left column. For each image type, you can upload
a separate image file that will be used as the watermark, define the size of the
watermark, and define the position in which it will be displayed relative to your
product images.

Design

There is more about this in the Assigning Designs at the product level section
below.
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Inventory

Inventory settings can be configured individually per product, however there are
also several very important global Inventory configuration settings. Additionally,
many of the individual product settings can be set to use the default value (the
global setting). Therefore, it is beneficial to discuss the product settings and
global settings together. Please refer to the section about Stock Management
later in this chapter for more detailed information.

Websites

Product In Websites |

¥ Main Website

Main Store

Englizsh
Ferman
French

I~ Udi Seven
Udi Seven 1

English Store Wiew

|l f youdre managing multiple Websites, you
product is associated by checking the checkbox next to the Websites from which

you want the product to be available. Each Website will display here with all of the
associated Stores and Store Views, so that you know exactly which Website you

are viewing.

Categories
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Product Categories |

= [T Root Catalog (0}
=L T Furniture (7
LM Living Roorm ()
L™ Bedroom (3}
=T Electronics (17}
LA [T Cell Phaones {5)
Sl Ccameras (3)
Lo T Accessaries (3)
L[ Digital Carmeras (3
LT Laptops i4)
S T Apparel (78)
U [ Shirts (32)
B[ Shoes (45)
LA T Mens (23
L Waomens (33)
LM Hoodies {13
B Pants (1)
| ¥ Suits (00
| [ Househaold tems (0)

This tab will display the global category tree, which a checkbox next to each
category name. Selecting a checkbox will associate this product to that category,
and you can select as few or as many associated categories as you wish. For the
categories to display on the homepage you must make sure to add the product to
a category below the root catalog. If you have not created a new category below
the root catalog then do so now.

Related Products/Upsells/CrossSells

Each of these tabs contains a product list, from which you can search for and
select products in your store which you wish to be related, up-sells or cross-sells
of the product being edited. There is more information about these three features
later in this chapter.

Product Alerts
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Product Alens

Price alert subscriphion was saved succossfully (a]
Fage |1 of tpages | View (20 =] perpage | Tolal 3 ecords found [
P e Lt Hamee Lrmail Prica Date Sutiscrileod Lawt hotsl slson Gend Counnl
Cherith Cutesiony chari@emmple com § 29000 Age 28, J000
Santos L Halper santos@example com B 29000 Ape 26, 2008
Professor Peler Wan Mostrand Pl im pld com 29999 Apr 26, 2008
Page 1 of 1 pages | View 20 ﬂ per page | Total 1 records found [
Fir gl Hadmen Last Magmo Lrmas Ll o Sbvse ring) L st Hustdlis glooe fenmd Gt
Cheérith Cutestory cherdh@esample com &gr 11, 2008 o
L.‘"'J T IV T Tt IT W MU U D MIUIT L U b S IS IO T LI LA WV I A O S o vy

list of all subscribers to both Price Alerts and Stock Alerts for this product. For
each subscriber, both alert lists show the name, email, the date they subscribed
to this alert, the time that the most recent notification was sent to them, and the
number of times a notification was sent to them. For the Price Alert, this is also
one additional column. For each subscriber, it shows the price that the product
had at the time they they described. This includes Special Prices. There is more
information on how to configure Product Alerts earlier in this chapter.

Custom Attributes

Jacket Attributes
Calor | Black 7] [eLoBAL]
Button Count | Three =] sLosal)

If you have added any custom Simple Attributes, make sure to configure those as
well. These can be scattered throughout the existing tabs, or you can create new
tabs in which to put them. It all depends on the configuration of your Attribute Set.
In this case, the suit jacket Simple Attributes are in a new tab called Jacket
Attributes.

These are all of the tabs which appear when creating a new product. If you press
Save And Continue Edit , you will see three new tabs appear in the left column.

Product Reviews

Youodl | see a |list of all reviews that have
information about managing Product Reviews in Chapter 9: User-Generated
Content.
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Product Tags

Shows all tags that this product has been given by users, and the number of
times each tag has been used. Chapter 9 also has more information about
managing product tags.

Customers Tagged Product

A breakdown of individual customers who have tagged this product - the grid
shows their first and last name, email, and tag used.

When you have completed all of your edits, press Save. You have now created a
Simple Product.

Creating a Configurable Produc t

1. By its nature, a configurable product is not useful unless there are
simple products which can be associated to it. Therefore, the first step
in creating a Configurable Product is to create two or more simple
products, containing different attributes, that your customer will be able
to configure on the front-end. Once you have created one Simple
Product, use the Duplicate Product feature to create the separate
products without having to enter every value several times. Once you
have created and saved your first product select the Duplicate button
on that productdés page. For the duplic
values which you are going to allow your customers to configure. Only
Simple Products will have a Duplicate button. Note: The values of
unique attributes (such as SKU) will not duplicate to the duplicated
product, and these will need to be entered manually. The duplicated
product will be created with a Status of Disabled. If you have forgotten
to create all of the Simple Products prior to creating the Configurable
Product, you will have the option to create Simple Products during
product creation, in the Associated Products tab (more below).

2. To create a configurable product, navigate to Catalog > Manage
Products.

3. In the top right corner, click Add Product .

4. Select an Attribute Set. Select Default i f you havendét creat
attribute sets. This will determine what product data you can enter. You
can refer back to the previous section for more information about
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managing Attribute Sets.
Create Product Settings

Attribute Set ' SuitJacket =

Froduct Type ! Configurable Product ﬂ

Continue

. Select Configurable Product

. Click Continue .

. Select Configurable Attributes.

Select Configurable Attributes

o' Only attributes with scope “Global", input
type "Dropdown™ and Use To Create
Configurable Product "Yes" are available.

Colar ¥

Button Count

Continue

For
an attribute to be listed here, it must be associated to the attribute set
which you selected in step 4, and it must not be a System Attribute.
Also, as described in the message on the page (see image above), The
Scope must be Global, the Input Type must be Dropdown, and Use To
Create Configurable Product must be Yes. If an attribute is selected, it
will not be configurable in the admin (as opposed to Simple Products,
for which all attributes are configured in the admin). Instead, a drop-
down menu will appear on the front-end for this attribute, and the
customer will be able to configure it.

Color:  Choose option... =l
Button Count: | Choose opfion =

The options from which
your customer will be able to select will depend on which Simple
Products are associated to this Configurable Product (more on this
below). If an attribute is not selected in this step, it will be configured in
the admin just like is done for a Simple Product, and it will be fixed on
the front-end. For example, if you were to select Color to be
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Configurable and Button Count not to be, then you could select the
Button Count to be Three in the admin, and associate one Simple
Product suit jacket with a Color black and one with a Color navy. On
the front-end, the suit jacket Button Count will be set at three, but your
customer will be able to select their preferred Color, black or navy, from
the drop-down.

8. Press Continue.

9. Enter all product information. This is almost exactly the same process
as entering the product information for a simple product. There are,
however, three major differences.

Weight

When a customer purchases a Configurable Product, they are not actually
purchasing this product, but rather one of the associated Simple Products.
Therefore, there is no weight for a Configurable Product, because the weight
depends on that of each Simple Product individually.

Inventory

Just like weight, the inventory options for a configurable product depend on those

of the individual Simple Products. In the Inventory tab, you can set the

configurable product to be In Stock or Out of Stock, but nothing more. If you

select In Stock, it will display as In stock on the front-end, but each attribute will

only be purchasable if the corresponding simple product is In Stock. If your

customer selects an Out of Stock attribute and adds it to the cart, they will receive

a message saying AThis product is current|
Stock, the configurable product will display as Out of Stock on the front-end, and

will not be available to add the cart, regardless of the Stock Availability of each

Simple Product.

Associated Products

This tab does not exist for Simple Products. At the bottom of the page will be the
product list from which you can associate or disassociate Simple Products to the
Configurable Product. When first navigating to the page, it will only display
currently associated products. Press the Reset Filter button to display all
products, associated or not, which belong to the same Attribute Set (a Simple
Product must belong to the same Attribute Set as the Configurable Product in



order for you to be able to associate it). Select the checkbox of all products you

wish to associate. The product list displays certain pertinent information about the
Simple Products. To the right of the Inventory column will be a column for each
configurable attribute, which you selected in step 7. The value entered for each
attribute col umn @ptidn|whibheyoutsdieatéd when orehting t 6 s
the Simple Product. In order for a Simple Product to display in this list, you must

have selected an option for each configurable attribute.

Above the product list will display a list of all configurable attributes. Click and
drag the orange arrow next to the attribute name in order to sort the attributes as
they will appear on the front-end. The Attribute Nam e field will be prepopulated
with the Label you used when creating the attribute, however it can be changed
here so that it displays differently in the front-end. Below each attribute will list all
the options that exist for associated products. Each time you associate a new
product with a unique option, the option will add to this list. For each option, you
can enter a positive or negative Price, which will add or subtract (respectively)
from the price of the configurable product, as either a Fixed amount or a
Percentage of the Configurable Product price.

Create Sirtphe Assochsted Product

Super product attributes configur ation

w Price values for options should be specfied in sysiem bise o renco.

¢ Cosbosr Attribuo Namis: Color
Opban Black Frite Fued |
Opbor Maw Prica: |5 Fued =]
¢ Dutton Count Artribete Mam: Button Caurt
Opan: Thees Prita Fued =]
Opfar: Fous Price: 10 Foed x|
Pape 1 oft pages | View |20 =] perpsge | Total 4 records found m w
I o HaiTie Artrib, Set Haimee E= 1) Priee Bt ooy Cobog IBantiosny C oiant Aetion |
Ay =] = From: | B | k|
To:
=2 1 Bilatk Sud Jacked Sull Jacksl black_jackel_1 § 19898 In S0ck Black Thresa
=2 5 Black Sud Jackel Sult Jackst black_jacket_2 § 30098 In S0k Brack Four
(=3 B Mawy Sun Jacked Sull Jackel navy_jackel_1 $ 30499 In Stock Ny Thrse Edil
=) T My Sun Jacked SunJatkes R _iackel_2 £31499 InSaock Many Faur

If you have not already created all of the Simple Products you wish to associate to
this Configurable Product, you will have the option to create Simple Products in
this tab. Above the list of configurable attributes is the Create Simple Associated
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Product section. This contains a button called Create Empty . Clicking this button
will generate a pop-up window identical to the New Product page. All of the fields
are empty (hence the name of the button), and you will be required to enter
values for all configurable attributes (so that this Simple Product can be
associated to the Configurable Product). When you click Save, Magento will
create a Simple Product, associated to the same Attribute Set as the Configurable
product, and Magento will automatically associate the Simple Product to the
Configurable Product (you will see this update in the product list at the bottom of
the Associated Products tab).

In the front-end, it will look like this:

Color: 'E'Ilack' j '
=]

Axvailability: In stock.
§ 299.99

Oty IR e. il OR  AddtoWishiist

These are all of the options which appear when creating a new Configurable
Product. If you press Save And Continue Edit , you will see two new options in
the Associated Products tab (along with the three new tabs in the left column that
were mentioned in the Simple Product Section). In the Create Simple Associated
Product section, there is a new button called Copy From Configurable . This is
similar to the Create Empty button, except that it will prepopulate many of the
Simple Product fields with the corresponding fields from the Configurable Product.
Many of the fields, however, either must be unique to each product, or are not
applicable to the Configurable Product, and must be entered manually. These
include SKU, Weight, all configurable attributes, and all Inventory information.
Clicking Save will automatically associate the Simple Product to the Configurable
Product just as with the Create Empty feature.

The second new option available is Quick simple product creation  section. This
section includes only some of the attribute fields, all of which are mandatory. In
the Name and SKU fields, there is an Autogenerate checkbox. If these are
selected, Magento will use the Name and SKU of the Configurable Product to
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create a new Name and SKU for the Simple Product. It will be in the format
[Name/SKU]-[configurable attribute 1]-[configurable attribute 2] and so on. When
you click Quick Create , the Simple Product will be created, with all of the attribute
information not listed in this section copied from the Configurable Product, and it
will automatically associate to the Configurable Product just as with the Create
Empty feature.

Create Sinple Associted Produc

Chaick sanple prodisct creation

Mame * it st
F Autogenerats

SKL* i Bkt AL CIAL|
W Autogeneate

Waight *

Status * - Please Sedect - ﬂ I

WVigibingy = —- Please Selecl— ﬂ """"

Colee ™ ﬂ

Button Counl * :J

L= o

Stock Availabiity in Stock =

When you have completed all of your edits, press Save. You have now created a
Configurable Product.

Creating a Grouped Product

1. Like a configurable product, a Grouped Product is not useful unless
there are simple products which can be associated to it. Therefore, the
first step in creating a Grouped Product is to create two or more simple
products that can be purchased together as part of the group.

2. To create a Grouped Product, navigate to Catalog > Manage Products.

3. In the top right corner, click Add Product .

4. Select an Attribute Set. Select Default i f you havenot
attribute sets. This will determine what product data you can enter. You
can refer back to the previous section for more information about
managing Attribute Sets.

5. Select Grouped Product .

6. Press Continue .

creat
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7. Enter all product information. This is similar to entering the product
information for a Simple Product, with four major differences.

Weight

This is the same process as a Configurable Product. When a customer purchases
a Grouped Product, they are not actually purchasing this product, but rather one
of the associated Simple Products. Therefore, there is no weight for a Grouped
Product, because the weight depends on that of each Simple Product individually.

Prices

Unlike Simple or Configurable Products, Grouped Products do not have their own
prices. Despite being displayed on the same page, each Simple Product adds to
the cart as a separate item. There are no prices that are applied to the items as a
group. Therefore, there is no Prices tab for Grouped Products. If you want to give
a discount when your customer purchases multiple products within a Grouped
Product, you can set up a Shopping Cart Price Rule for this. There is more
information about Shopping Cart Price Rules in Chapter 5: Promotions, Marketing
and Content Pages.

Inventory

Just like Weight, the stock of the individual Simple Products determine the stock

of the Grouped Product. The Stock Availability works like that of a Configurable

Product. If you select In Stock, it will display as In Stock on the front-end, but

each Simple Product will only be purchasable if that Simple Product is In Stock. If

your customer attempts to add one or more of the Out of Stock products to their

cart, they wil!|l receive a mesys aogd sdadyisng cik
you select Out of Stock, the Grouped Product will display as Out of Stock on the

front-end, and will not be available to add the cart, regardless of the Stock

Availability of each Simple Product.

Associated Products

This is much simpler than associating products to a Configurable Product.
Grouped Products do not need to be in the same attribute set as their associated
products, so there is no attribute functionality tied in with creating Grouped
Products. You can associate any product to a Grouped Product in this tab by
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checking it. When checked, two fields unlock: Default Qty and Position .

r 1] Tty Kl [ ] Dt aidlt dny
Ay _'_'] olack Frome From:
To: Ta:
F i Black Wesl Black_vesl 1 § 5484
F 1a Black Pamis Black_paris_1 $99.99
F L Eilack St ac ket Black_jacket_1 § 20990

Pora®ion

Frome

Control the sort order of the items in the Position field. As with all sort orders in
Magento, the product with the lowest number will have the highest position on the
page. You can also enter a Default Quantity which will be a pre-populated value

in the front-end quantity box.

Three-Piece Suit

He the first to review this product

Sign up for price alert

Product Name Price Oy
Black Suit Jacket $ 2995949 1
Black Pants F99499 1
Black Vast §54999 1

Availzbility: I stock.

OR Add o Wishlist
Quick Overview
- + Still waaring that leisure suit that you wore 1o your cousin's

wedding in 19787 Step into stde, and the 21 51 century, with

MORE VIEWS

LK

this designer three-piece sult.

When you have completed all of your edits, press Save. You have now created a

Grouped Product.

Related Products, Up-sells, Cross-sells

There are three types of product relations in Magento: Related Products

sells and Cross -sells . Shown on a product&s

Up-
page,

to be purchased in addition to the item the customer is viewing. They will appear
in a Related Products menu at the top of the right column. Simple Products will

Rel
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have checkboxes, by which the customer can add them to their Shopping Cart.
When they add the main product to their cart, all checked Related Products will
be added as well.

& RELATED PRODUCTS

Check items= to add to the cart
or select all

W | | Black Parts
% 99.99
Add to Wishlist

[¥: [SiZa | Black vest
$ 59,99
£ | Add to Wishlist

Configurable and Grouped Products will not contain this checkbox, because the

user must specify the settings of these products before adding them to the cart.

Al so shown on a psell®ateutents that cuptarmrs woultlideally
buyinsttadof t he product theyodére viewing. These
a higher profit-margin, be more popular, etc. They will appear in a section labeled

You may also be interested in the following product(s) , Which displays

beneath the Additional Information  section. The Up-sells will display with a link

to that productds page, navi gat iwhightheyhe <cus
are currently viewing.

You may also be interested in the following product(s)

A Jacket that's way Another Jacket that's Better yet again
better than the jacket bhetter

yvou are looking at $599.99

e % 499.99

$399.99

Shown in the shopping cart, Cross-sells act a bit like impulse buys, such as
magazines and candy at the cash register in grocery stores. Usually, they are
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items that a customer who is buying the product in question might enjoy. If there
are multiple items in the Shopping Cart, each with their own Cross-sells, the
Cross-sells will rotate each time the Shopping Cart is refreshed.

Based on your selection, you may bhe
interested in the following items:

Impulse Buy #1
$0.99

Add to Wishlist
Add to Compare

Impulse Buy #2
$4.99

.
Add to Wishlist
Addd to Compare

Great For:

A Moving Stock
A Increasing the Sales of Accessory and High-End Items

Related Products, Up-sells, and Cross-Sells are all associated to a product in the
same manner. Navigate to Catalog > Manage Products. Locate the product to
which you wish to associate the Related Product/Up-Sell/Cross-sell, and click
Edit. Click on the Related Products/Up-Sells/Cross-sells tab in the left column.

1. From the products grid that appears, check any products to mark as
Related Products/Up-Sells/Cross-sells. Click Reset Filter to see all
products.

2. Once a product has been checked, the Position field opens up. This
determines the sort order of the Related Products/Up-Sells/Cross-sells
i n the product 6s Note:de Cr8ss-sefisptherPasitioda r t .
only applies if there is one item in the cart. When there are multiple
items, the Cross-sells will rotate, and not adhere to the Position.

3. Click Save.
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Search
Product Comparisons

One property of Magento attributes is the ability to make them Comparable on
Front -end. If at least one attribute is in a product is Comparable on Front-end,
customers will be able to add this product to their Compare Products menu. Both
System and Simple Attributes can be set to Comparable. Once added to the
Compare Products menu, customers will be able to view the products side by side
and make an educated shopping decision. This is very powerful; if customers
desire, they can compare a chair, a television, and a pair of running shoes. These
types of products may not have very many attributes in common (probably only
attributes such as SKU, Price, and Product Name), but that is the power of this
feature: to allow your customers to customize their shopping experience. There is
more information about Product Comparisons in Chapter 5: Promotions,
Marketing and Content Pages.

Great For

A Increasing Customer Convenience
A Stores with a Variety of Products
A Increasing Conversions

You can control which data shows in Product Comparisons. Each product
attribute has a flag called Comparable on Front-end, which can be set to Yes or
No. To choose this:

1. Navigate to Catalog > Attributes > Manage Attributes.

2. In the grid, find the attribute you want to edit. Hint: Change the last
column Comparable to Yes or No to see all attributes that can appear
in the product comparison chart.

3. Click the attribute to edit it.

4. Change the drop-down Comparable on Front -end to Yes or No.

5. Click Save Attribute .
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Layered Navigation

A customer browsing your site needs to find the products that interest them as
fast as possible. To prevent them from frustrating experience of encountering a
category containing 60 products spread across multiple pages, give them the
option to filter products based on their interests. With layered navigation,
customers can search by any attribute that you have designated as filterable,
more easily showing customers what they want and raising conversions.

Great For

A Stores with a variety of products
A Giving customers a more individualized experience
A Increasing Conversions



The Layered Navigation menu actually consists of two parts: Category filters and

Home ! Electronics # Cameras

SHOP BY

SHOPPING OPTIONS

& CATEGORY |
ACcRss0ries (3

Digital Cameras (4]

£ PRICE

§ 0.00- § 100.00 (4)
$100.00 - § 200.00 (2)
§ 300.00 - § 400.00 (1)
§ 500.00- § 600.00 (1)

E COLOR
Black (1)
Silver ()

E MANUFACTURER
Argus (1)

Canon )

Kodak (1)

Qlyrmpus (1)

£ MEGAPIXELS
562
m
52

Attribute filters.

A Category navigation - If a category contains child categories, the child
categories will automatically display in the Layered Navigation menu. Each
child category will display as a link, along with the number of products
associated to that category in parentheses. Only the direct child categories will
display. Child of child categories will not display.

A Attribute filters - In order for the attribute filter to display in the Layered
Navigation menu, a category must be an Anchor category (refer back to the
section about categories). For Anchored categories, all filterable attributes will
have a section in the Layered Navigation menu, with a link for each value.
Clicking on any of these values will filter the results on the category page to
display only those products which match the selected value (refer back to the
section about attributes for more information about filterable attributes). There
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will be one link for each existing value. There is one exception to this,
however. Price, which is a System Attribute, is by default configured to be a
filterable attribute (this can, of course, be changed). Rather than having a
separate link for every single price, the price filter values will display as various
price ranges. Magento will automatically set the size of the ranges based on
the prices of the products in that category (each range will be of equal size),
and there will be a maximum of ten ranges.

Assigning Designs at the product level

You can control the look of each product page individually in from the Design tab
in the product page. It is very similar to the individual design options for
categories. If your product page has a design separate from the category page to
which it is associated, then the product level design will supersede the category
level design.

A Select the design you want from the Custom Design drop-down. Magento

comes with several different design options out of the box. If you leave this

drop-down blank, it will automatically use the Current package nam e design.

This can be edited by navigating to System > Configuration and clicking the

Design tab. Enter the name of the design you want in the Current package

name field, and this design will apply to all products for which you do not

specify a different design.

With the Active From and Active To fields, you can select a time frame in

which the category will automatically switch to a design, and then switch back

to the blank option when the time frame ends. This is perfect for the holidays,

so that you can create a holiday design for your pages, and then have your

site automatically switch back to the normal design whenever you want,

without having to remember to do it yourself.

The Custom Layout Update is essentially a static block, with a few

differences.

A Rather than HTML, the structure must be in XML format.

A The Update will display on the product page, below the product
information, whereas a static block will only display on a category page.

A The Update will display on the page only during the dates specified in the
Active date range.



Stock Management

Your ability to manage the details of your productsd invent
Management System. You will have the ability to control not only the quantity and availability, but also the
backorder capabilities and the maximum and minimum quantities the consumer is allowed to purchase.

Additionally, you can create the settings system-wide, or customize them individually for each product.

Creating stock management default options

1. Navigate to System > Configuration, and click on the Inventory tab in the left column.

Stock Options

Minimum Gty Allowed in
Shopping Cart

[l otify for Ciuantity Below

Minirmum Qty for lterns’ |20
Status to be In Stock

Maximum Sty Allowed in 10000
Shopping Cart

Decrease Stock'When ir‘:r-'ea j
Orderis Placed

Backorders §N|:| Backorders iv|
Mo Backorders
)l oy City Below 0

Allawy Sty Below 0 and Matify Custamer

1. Enter Minimum Qty Allowed in Shopping Cart . This value requires the customer to purchase a
minimum amount of each product in an order.

2. Enter Notify for Quantity Below . When a stock of any product goes below this level, Magento will
automatically notify you via RSS Feed. This ability works in conjunction with the Decrease Stock
When Order is Placed drop-down below, because Magento cannot notify you of a low stock unless
you also enable it to keep track of stock reduction. In this field, enter the quantity level at which
Magento will send a notification. In order to set up the RSS feed, navigate to Catalog > Manage
Products, and click the Notify Low Stock RSS link at the top of the page. You will be prompted to
enter your User Name and Password. These are the same that you use to access the Magento
admin panel. You will be redirected to the RSS page, where you can select which reader you would

like to use for receiving this feed.
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3. EnterMi ni mum Qty for | t e ms &ThBvawée willdetarnine btevhidh quariity o ¢ k
the availability of the item will switch from In Stock to Out of Stock. If you set this value to 20, you will
always guarantee that you have at least 20 items in stock.

4. Enter Maximum Qty Allowed in Shopping Cart . This value limits the amount of each product the
customer is allowed to purchase in a single order.

5. Select Decrease Stock When Order is Placed status.

Al f you select Yes, the productédés quantity wil!/ aut c
Al f you select No, t hoeautpmaticalydedrease, andut aam oniy beyedited | | n
manually.

6. Select Backorders status.

Alf you select No Backorders , the customer will not be allowed to purchase more quantity than
is available.

Alf you select Allow Qty Below 0 , the customer will be allowed to purchase more quantity than
is available, but they will not be notified that some of the quantity has been put on backorder.

Alf you select Allow Qty Below 0 and Notify Customer , the customer will be allowed to
purchase more quantity than is available, and they will be notified when they are adding the
item to the cart that the unavailable quantity has been put on backorder.

7. Click Save. You have now created the inventory characteristic for all products in your system.

Creating stock management on the product level

To customize the inventory settings for an individual product, whether creating a new product or editing an
existing product, navigate to Catalog > Manage Products, and click the Inventory tab in the left column of the
pr oduct dste: Thasg settings only exist for Simple Products. Because Configurable and Grouped
Products are essentially just a way to display Simple Products, the inventory settings of the Configurable and
Grouped Products are completely dependent upon those of the associated Simple Products. Therefore, for

Configurable and Grouped Products, only the Stock Availability will be present in the Inventory tab, because this



is actually a display setting and not related to the actual inventory of the product.

Imventory
Gy a7 [GLOBAL]
Minimum Gty far tem's in [ZLOBAL]

Status to be Out of Stock ¥ Usze Config Settings

Minirmurm Gty Allowed in |0 [GLOBAL]
Shopping Cart ¥ Use Config Settings
Maximurm Sty Allowed in :-I:I [ZLOBAL]
Shopping Cart ¥ Use Config Settings

. | -
Gty Uses Decimals Mo J [GLOBAL]
Backorders ﬁllnw Qty Below 0 and Motify Customer j [GLOBAL]

[T Use Config Settings

Matify far Quantity Below |0 [GLOBAL]
¥ Use Config Settings

Stock Availability | In Stock ¥ eLoBaL]

1. Enter Qty, or quantity. This is a required field.

2. EnterMi ni mum Qty for |t e ms 6orddkthe Uss Config Seltiegs |checkBox o c k
use the value you input in the Inventory System Configuration. Clicking the checkbox will deactivate
the text field and it will not be editable.

3. Enter Minimum Qty Allowed in Shopping Cart  or click the checkbox.

4. Enter Maximum Qty Allowed in Shopping Cart  or click the checkbox.

5. Select Qty Uses Decimals status.

Alf you select Yes, the customer can enter a fraction of a whole number into the quantity field in
the shopping cart. This is beneficial if items are being sold in alternative units such as weight
or length.

Alf you select No, the customer can only purchase quantities in whole numbers.

6. Select Backorders status, or click the checkbox.

7. Select Notify for Quantity Below , or click the checkbox.

8. Select Stock Availability . You can designate the product to be Out of Stock even if you have stock
remaining for the product, and it will display as such in the front-end. This means that your customers
will not be able to add the product to their carts, but they can add it to their wishlists. If there is no
stock remaining for the product, you do not need to manually switch this to Out of Stock. Magento
will automatically update the front-end accordingly, unless you allow for Backorders, in which case
the product will display normally and customers will still be able to add quantity to their carts.

9. Click Save. You have now customized the inventory characteristics for this product.
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Batch Updates

Products can be imported to and exported from the admin using the Magento
DataFlow engine. However, in this section we will concentrate on making batch
updates to products in the admin. This feature saves you time by allowing you to
change the attributes of multiple products at the same time. There is similar
functionality in several other places in the Magento admin, from customers to
Orders. Each will be discussed in the appropriate chapter.

1.
2.

In the admin, navigate to Catalog > Manage Products.

Select the products to which you would like to make updates. At the top
of the products list, you have the option to Select All products or Select
Visible products (products currently displaying on the page). Or, you
can simply check the checkboxes of each product to which you wish to
make updates individually. You can see the number of items selected
at the top of the products list, and it will update each time a checkbox is
checked or unchecked.
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When you have all the desired products selected, chose your preferred
Action from the drop-down menu, also at the top of the products list.

A Delete - This will delete the selected products from your catalog
when you press Submit .

A Change Status - Selecting this will produce a Status drop-down
menu to the right, where you can choose to either Enable or
Disable the selected products. The status will change when you
press Submit.

A Update attributes - When you press Submit, you will be
redirected to the Update attributes page. The Attributes tab
displays many of the system attributes from the General, Prices,
Meta Information, Images, and Design tabs in a product page. It
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also includes the simple attributes that are shared by all of the
items selected. You will not have the option to edit SKU or URL
Key, or any other attribute that must be unique per product. The
Inventory tab displays the same fields that are displayed in the
Inventory tab for an individual product. The Websites tab is also
very similar to that of an individual product, however there will
be one section for adding the products to the Websites, and
once section for removing the products from the Websites. In
the top left corner is the Choose Store View drop-down, so that
you can choose to make your updates specific to a certain Store
View. As always, Global and Website level attributes cannot
differ between Store Views. At first, all the of the attribute fields
are inactive, and you must click the Change checkbox next to
each field in order to activate it and make an edit. The fields will
all be blank, even if all the selected products share the same
value for a given attribute. This can be useful for many
scenarios. For example, if you have several products with the
same special price, ending in one week, you can choose to
extend the Special Price To Date for all the products at one
time. Simply check the checkbox for this field, enter the new
date on which you wish the special to end, and click Save.

[T Change

Special Price From Date [ [T Change [EBSITE]

Special Price ' [WEBSITE]
[ Change [USD]

Special Price To Date 04530008 |5 W Change [EBSITE]

_Ctatiie * Dl O st 'I W ELY == sl = |

All of the products will update and you will be redirected back to
the products list. Tip: Be careful to only check the attributes
which you wish you change. If you select an attribute and leave
it blank, it will erase the existing value of the attribute when you
save.
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URL Rewrites

The URL Rewrite Management page is a SEF tool that you can apply to the URLs of your category and product
pages. Rather than having all your URLSs in the default format, which uses category and product IDs, you can use
this feature to create a more descriptive URL, making it easier for search engines to find your pages. Whenever a

new category or product is created, a new entry will be added to this list, one for each existing store view.

Configuration Settings

Before using this feature, there are two important settings that you must configure. Navigate to System >

Configuration and select the Web tab from the left column.

A Add Store Code to Urls - This determines whether the store ID (in addition to the category ID or product ID)
will be used in the URLSs for your site. If you are managing multiple stores, this will create a separate URL
rewrite for each store.

A Use Web Server Rewrites - This controls whether Magento will automatically generate URL rewrites. To

access the list of existing rewrites, this must be set to Yes.



Editing URL Rewrites

Now you are ready to view the list of URL rewrites. To access this list, navigate to Catalog > Manage Url Rewrites

in the admin. Click Edit next to one of the rewrites and you will be able to change some of the information.
General Information

Type ™ | Systern j
&l

Store * | Burmese

IO Path* Eprnductﬂﬁ

Target Path* !catalugiprnducb‘wiewﬁdﬂ a

Fequest Path * !bambnn-barcglDna-_platr'l:urm-be_d.html

Fedirect !‘r’ea 3
Drescription

A Type - For automatically created rewrites, this value will be System. For manually created rewrites, this value
will be Custom. Neither can be changed.

A Store - The name of the store view to which the rewrite directs. Because a separate rewrite is created for
each existing store view, this too can not be changed.

A ID Path - Will display in the format of {Type}/{ID#}. If the Type is System, it will further be specified as either
category or product. For products, there may also be an additional /{associated category ID#} following the
standard format. This can not be changed.

A Target Path - This is the actual URL that points to the page. It is a relative path, automatically generated in a
certain format, and can not be changed.

A Request Path - This is the SEF URL that you can edit. It will be automatically generated with the name that
you specified for the category or product when it was created. If it is a product, it may also include the
associated category, or a suffix (such as .html), if you have enabled those features in the Catalog

Configuration (refer back to the beginning of this chapter for more information about this). However, you can

edit this to whatever format you desire. This is the same field that you see in an individual product or category
page called URL key. To find this field, navigate to Catalog > Manage Products/Categories and edit the

desired product/category. Whether you choose to edit the value in the URL Rewrite Management page, or
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the individual product/category page, it makes no difference. Note: The Request Path must be unique for
each rewrite.

A Redirect - If you select Yes, the URL will switch to the Target Path when the Request Path is entered in the
address bar. If you select No, the URL will remain in the format of the Request Path.

A Description - This is for internal purposes.

When you have completed making edits, click Save Url.

Creating URL Rewrites

You can also create New Url Rewrites. Because Category and Product pages automatically generate a rewrite
when they are created, this is most useful for adding multiple Request Paths that point to the same Target Path.

Additionally, you can create rewrites that point to CMS landing pages, such as a FAQ page.

1. Onthe Managage Url Rewrites page, click Add Url Rewrite .

2. Select the Type

Add New Urlrewrite

Please select a type

Create Utlrewrite for * ; ;v|

Categary
Product

A Category - If you select Category, you will then be required to select the category for which you wish to
create the rewrite from the category tree. Select the checkbox of the desired category. You will then be
redirected to the General Information page where you enter the relevant information. You will have the ability
to choose the Store from a drop-down. And just like when editing an existing rewrite, you can make changes
to the Request Path (which will be autopopulated with the category name), Redirect and Description. When
you are finished, click Save Url.

A Product - If you select Product, you will first be required to select the product for which you wish to create the
rewrite from the product list, and then be redirected to the category tree where you will be required to select
the category to which the product is associated. Then, you will be redirected to the General Information page
where you enter the relevant information. The name of the product will be displayed at the top as a link to the
pr odu c tmaten page.fYourwill have the ability to choose the store from a drop-down. And just like when

editing an existing rewrite, you can make changes to the Request Path (which will be autopopulated with the
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product name and associated category name), Redirect and Description. When you are finished, click Save
Url.

Custom - If you select Custom, you will be redirected immediately to the General Information Page. As with
the Categories and Products, you will be able to edit the Store, Request Path, Redirect, and Description.
However, because you cannot select Target Path from a list of Categories or Products, you will have to enter
the ID Path and Target Path manually, to point to the desired CMS landing page. Just as with Categories and
Products, the Request Path field exists in an individual CMS page. Here, it is called SEF URL Identifier , and
you can find it by navigating to CMS > Manage Pages and clicking on the desired CMS page. When you are

finished, click Save Url.



Chapter 4: Get Ready for Selling

Checkout Process

In this chapter we will discuss the details of the checkout process, including localization, Taxes, Shipping

Met hods, and Payment

Met hods.

But

before

describing each ac

moment to discuss the checkout process as a whole, along with some of the basic checkout configuration

settings. This way, you will have a better understanding of how localization, Taxes, Shipping, and Payment fit into

the checkout process, giving each section a bit more context.

The process first begins when your customer adds a product to their cart. They can be redirected to the cart each

time they add a product, or remain on the product page, only to be directed to the cart if they click one of the

various shopping cart links. You can configure this setting by navigating to System > Configuration, clicking on the

Checkout tab in the left column, and choose your preference from the After adding a product redirect to

shopping cart drop-down. Magento automatically saves the contents of yourc ust omer sd shopping

can limit the amount of time a product will remain in the cart by entering the limit, in days, in the Quote Lifetime

field. If your customer continues shopping, they will have a quick view of the shopping cart in the right column of

all category, product and CMS pages that include the right column (which you can specify in the design settings

for each page individually).

2 MY CART
There iz 1 kem in your cart.

Cart Subtatal: § 550,00

Checkout

Recently added itemni(s)

.

@

Canon Digital Rebel
HT BMP Digital SLE
Camera

"1 F550.00

®

At the top of the cart view will be a summary of the quantity of items in the cart. This can display either the

number of different products (line items) or the total quantity of each line item. You can specify this setting in the

Display Cart Summary drop-down.

When your customers arrive to the shopping cart, they will see each product listed in a separate row. Each

product here is referred to as a line item. For each line item, your customers have the option to add quantity to it,

or remove it from the cart altogether, and this can be done at any time. The image that displays for each line item

cart
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is the Thumbnail image that you selected for each product. For Grouped and Configurable products, however,

you have the option to use the Thumbnail of the Grouped or Configurable product, or the Thumbnail of the
associated Simple Product. This is designated in the Grouped product image and Configurable product image
drop-downs, respectively. To use the Thumbnail of the Grouped/Configurable Product, select Parent Product
Thumbnail . To use the Thumbnail of the associated Simple Product, select Product Thumbnail itse If. In the cart
there is also a link to Continue Shopping , so that your customers can add more products to the cart. If they have
a coupon code which will offer them a discount, they must enter it in the Shopping Cart, in the Discount Codes

field (there is more information about Shopping Cart Price Rules in Chapter 5: Promotions, Marketing and Content

Pages), in order for it to be applied during Checkout.

“¢ DISCOUNT CODES

Entervyour coupan code ifyau have one.
-savm III. . Apphy Coupon ‘h

When they click the Apply Coupon button, the coupon will be applied to the cart and appear in the checkout

totals in the bottom right corner. Your customers can also receive Shipping and Tax estimates prior to the
checkout process. They must enter their Country, State/Province, and Zip/Postal Code in the Estimate Shipping

and Tax field, and click Get a Quote . The available shipping rates will appear directly below.
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& ESTIMATE SHIPPING AND TAX

Enteryour destination to get a shipping
estimate.

Country

United States =
StateProvince

Califarnia H
City

|Los Angeles

Zip/Postal Code

90064

Get a Quote

DHL

" Express - § 46.90

" Next Afternoon - $ 40,57

" Second Day Service - §21.02
" Ground - % 6.58

Flat Rate
" Fixed - § 10.00

Update Total

Your customers can then click the Update Total button, and the selected shipping rate, along with the tax (if
applicable) will add to the checkout totals in the bottom right corner. Your customers can change shipping rates at
any time, and refresh the checkout totals by clicking the Update Total button again. The checkout totals includes

the Subtotal, Discount, Shipping, Tax, and Grand Total.
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Suhtotal £ 550.00

Discount (savel 0 F-55.00

Shipping & Handling §6.58
(OHL - Ground)

Tax § 4592

Grand Total $ 547 50

Proceed to Checkout
IM#ES" ot & et ﬁ"--‘ :

The safer, easier way to pay

Checkuut -

Fazt checkout through Google

You can configure the order of these amounts by navigating to System > Configuration, clicking on the Sales tab

in the left column, and entering the sort orders in the Checkout totals sort order  section.

The tax will vary depending on the tax settings you specify. Navigate to System > Configuration, and click on the
Sales tab in the left column. Here, you can designate whether to Apply Tax after Discount . If you select Yes, the
tax will calculate as a percentage of the discounted price rather than the Subtotal. You can also choose the Tax
Class for Shipping , if you want to charge tax on the shipping costs (more on this in the Taxes section below).
Lastly, you can calculate the TaxBasedOn t he cust omer so6 bi |l | i thgshipping@igin(thepi ng addr
address of your store or warehouse, which you can define in the Shipping Settings tab). If you choose to base tax
on the shipping origin, which is a fixed address that you must configure, your tax rates will be fixed, and you will
then have the option to set Catalog prices include tax to Yes. If you do, Magento will subtract sales tax from the
product price you entered in the catalog. For example, you have a product listed for $110.00, and the tax rate is
10%. Instead of the customer being charged 10% on top of the $110.00, and paying $121.00 total, they will only
pay $110.00 total. The actual product price will therefore be $100.00, and the other $10.00 will be used as the
sales tax ($10.00 is 10% of $100.00). The $100.00 price will be shown in the shopping cart as the Unit Price
(Excl. Tax), or the price excluding tax, so your customers can see that the tax was already included in the catalog

price they saw in your site.
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Unit Price Oty Subtotal

F110.00 !1 | F110.00

Update Shopping Cart

Subtotal $ 110,00
Tax $11.00
Grand Total $121.00

| Proceed to Checkout |

Tax not included in catalog price

' Unit Price (Excl. Tax) oty ~ Subtotal (Excl. Tax)

£100.00 I1 | F100.00

Update Shopping Cart

Subtotal F100.00
Tax F10.00

Grand Total $110.00

Proceed to Checkout

I

Tax included in catalog price

When your customers have added all the items they want to purchase to the cart, they will click the Proceed to
Checkout button in the cart. There is also a Checkout button in the Shopping Cart quick view, and a Checkout

link in the page header at all times (if you have PayPal or Google Checkout enabled, separate checkout buttons
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will appear for these options). If they are not already logged in, they will have three options: Checkout as Guest ,

Register , and LOGIN.

n Checkout method

CHECKOUT AS A GUEST OR REGISTER LOGIN

Register with us for future comenience: Already registerad?

FPlease log in below:
" Checkout as Guest

¢ Register Email Address *
Register and save time!
Register with us for future convenience: Password *
* Fastand easy check out
s Easyaccess to your order history and status
* Reguired Fields
Continue Forgot your password?

If they choose to Checkout as Guest, they will enter all of the necessary order information, however an account
will not be created for them when the checkout is complete. You can disable guest checkout by navigating to
System > Configuration, clicking the Checkout tab in the left column, and selecting No from the Allow Guest
Checkout drop-down. If they choose to Register, they will enter all of the necessary order information, including a
password, and an account will be created simultaneously when the checkout is complete. If they choose to
LOGIN, they must first enter their Email Address and Password, which will retrieve all of their account information,
and they will only be required to enter the necessary order information which is not currently saved (for example,

if they do not already have any addresses saved to their account).

Regardless of which of these three options -pabeslyeckouhoos e, t he
platform. This makes the checkout process easier than ever, with all the checkout information conveniently
located on the same page, divided into separate tabs for better organization. The first tab includes the Billing
Information (as well as name, email, and password, if needed), and the ability to select from different addresses
and create new addresses. The second tab includes the Shipping Information, as well as the ability to change or
add addresses. In the first tab, your customers have the option to specify that the shipping address will be the
same as the billing address, in which case the second tab will be skipped altogether. The third tab will include the
available shipping methods, as well as the option to add gift messages, if they are enabled. Gift messages can be
applied to the order as a whole, or individually to each product. You can configure this by navigating to System >
Configuration, and clicking the Sales tab in the left column. The Allow Gift Messages on Order Level drop-down
controls whether one gift message can be placed for the whole order, and the Allow Gift Messages for Order

Items drop-down controls whether one gift message can be placed for each product. You can choose to enable
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both, or just one. In the Shipping Method tab, the Order Level gift message will have a From field, To field and a
Message field. The Iltem Level gift message(s) will have the same fields, as well as an indication as to which
product the gift message is associated. The From and To fields will autopopulate with the billing address name
and shipping address name, respectively. The fourth tab will include the Payment Information. The fifth tab will

include the Order Review, and the Place Order button, which completes the order.

B Order Review

" Product Name Price  Qty Subtotal
Canon Digital Rebel ¥T 8MP Digital SLRE Camera $550.00 1 § 550.00
Subtotal § 550,00

Discount (save 10} §-55.00

Shipping & Handling (OHL - Ground) $658

Tax $4592

Grand Tatal § 54750

Faorgot an hem? Edit Your Cart =

" Place Order

As your customers proceed through checkout, the information from each tab will be update in the Your Checkout

Progress menu in the right column.

Localization Settings

When you first installed Magento, you were required to select your localization settings. This includes you Locale,
Timezone, and Default Currency. Just because these were configured during installatondo e s ndt meant you dc

have access to them any time you want. These can be reconfigured at any time.

Locale Settings

You can reconfigure your Timezone and Locale settings by navigating to System > Configuration, and clicking on
the General tab. This page also contains other very import:

to discuss them along with the discussion of the localization settings.

Countries options

A Default country - Any time a country drop-down is present, in the admin or the front-end, it will automatically
be populated with the country selected from this list. The option you select here should be included in the

Allow countries list below.
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A Allow countries - Any time a country drop-down is present, only the options selected from this list will be

available to select in the drop-down.

Locale options
A Timezone - Controls all settings related to time in your site, such as timestamps or automated processes.

A Locale - Controls the default language of your site.
Currency

The other localization setting T Currency T can be reconfigured in a different location. In addition to merely being
able to select which currency will be your default currency, there are many other currency settings that you can

configure at this time as well.

Currency Configuration

To configure the currency settings, navigate to System > Configuration, and select the Currency Setup tab in the

left column.

Currencies Options

A Allowed currencies - Select from this list each currency with which you would like your customers to be able
to place Orders. This can be unique for each website or store view. The currencies that display in this list are
actually determined in another currency list. Navigate to System > Configuration, and select the System tab
in the left column. In the Currency section, there is a list of Installed Currencies . This list contains many
obsolete 20th century currencies in addition to the current ones. By default, only current currencies will be
selected, and therefore only those currencies will display in the Allowed currencies list. However, you have
the option to select the obsolete currencies, and add them to the Allowed currencies list. The Installed
Currencies list, therefore, acts like a filter, so that the Allowed currencies list is not cluttered with obsolete
currencies that most store owners will not use. If you select more than one currency from the Allowed
currencies list (and define currency rates, which will be covered below), a Select Your Currency drop-down
will appear on the category and product pages on the front-end, through which your customers can choose

their preferred currency method.



 Select Your Currency

FUS Dollar- UsD -
tistralian Dollar - AUD [
éCanadian Dallar - CAD |
Chinese Yuan Renminbi- CH
Euro - ELIR

Japanese Yen - JPY

Mexican Peso - WM

IS Dollar- USD
LIkrainian Honenia - LIAH

Default display currency - This is the currency that will be selected on the front-end when your customers
first arrive to your website, before changing it in the Select Your Currency drop-down. If you are only allowing
one currency in your site, this will be the same as the allowed currency. If you are allowing multiple
currencies in your site, you can choose which of those currencies will be the default. Make sure that the
Default display currency has been selected as an Allowed Currency.

Base currency - This is the currency against which all other allowed currencies will be configured, based on
the ratios established in the Manage Currency page (covered below). You can establish different Base
Currencies per website (so long as the Catalog Price Scope in the Catalog tab is set to Website ). Each
website level Base Currency will have its own row in the Manage Currency page. While you can allow
multiple currencies in which to display your product prices, this is the currency that will be used for payment
transactions with online payment gateways (this is only if you have enabled one or more online payment

methods in your Payment Methods configuration; there is more about this later in the chapter).

Import Settings

This section is to set up automatic updates of currency rates through an external currency rate provider. You can

manually update the currency rates using an external currency rate provider in the Manage Currency page

(covered below).

A
A

> > >

Enabled - Select Yes to Enable automatic currency rate updates.

Service - Select which external currency rate provider you with which you wish to update your rates. By
default, Magento is configured to import rates from Webservicex .

Start Time - Select the time of day (in 24 hour mode) at which you wish to update your rates.

Frequency - Designate whether you want the rates to update Daily, Weekly, or Monthly.

Error Email Recipient - Enter the email address to which emails will be sent in case an error occurs during
the automatic update.

Error Email Sender - Select the address from which the error notification email will be sent. For more

information on how to configure these email addresses, refer to Chapter 6: Customers.

Error Email Template - Select the template which the error notification email will use. For more information

on how to configure these templates, refer to Chapter 6: Customers.
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Currency Rates

These can be configured by navigating to System > Manage Currency Rates. This page contains a table of Base
Currencies and Allowed Currencies, with the relative value of each compared to the Base Currency. Each Base
Currency will have its own row, and each Allowed Currency will have its own column. When the row value and
column value for a cell are the same (for example, where the US Dollars Base Currency and Allowed Currency
intersect), the rate will be 1.0000. All other rates in the same row will be a ratio of this. You can enter the rates of
the other currencies manually, or import them from an external currency rate provider in the Import Service drop-
down. By default, Magento is configured to import rates from Webservicex . Select this from the drop-down, and
click Import . The Allowed Currencies will populate with the most current conversion rates. If you had rates
previously entered, they will now display underneath the field, as the Old rate . You can revert to these old rates

by clicking Reset. When your currency rates are configured correctly, click Save Currency Rates .

Manage Currency Rates Enpoit Sence mnm:hj EE E
HilHE L 1] (=] (21 il MER [ (£21]
ER i pEia T i1 1848 1 D80 164, 4477 18 TRET T @451 1 50
O rade 1 6ETH i et 1 6004 Crbel vt 10,1206 Oid ride- 162 BEES Cod rale 16,7623 e rabe T B0S g ride 1 5906
uso 1,058 0056 [0 k] DEIST plord i) 104055 4 5050 (i)
O e 1 (11 O eate 1 0062 Ong e 70015 o ranbec 90 Bl Oid ealn 1000150 N rate 10 5000 Ol et & G060

There are 2 base currencies (1 per Website) and 8 display currencies
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Y¥OUR CHECKOUT PROGRESS
| Billing Address | Edit
Magento Commerce
Varien
11832y Pico Blvd
Los Angeles, 90064,
Califarnia

Linited States
T: 1-310-954-801 2

| Shipping Address | Edit |

Magento Commerce
Varien

11832y Pico Blvd
Los Angeles, 90064,
California

Linited States
T:1-310-854-8012

| Shipping Method | Edit |

CHL - Ground: § 6.53

| Payment Method | Edit |

Mame on the Card: Magento
Credit Card Type: Visa
Credit Card Mumber:
w1111

Expiration Date: 0172010

If you wish, Magento will automatically notify you via RSS Feed of the creation of all new Orders, whether created
in front-end the or the admin. In order to use this RSS feed, navigate to Sales > Orders, and click the New Order
RSS link at the top of the page. You will be prompted to enter your User Name and Password. These are the
same that you use to access the Magento admin panel. You will be redirected to the RSS page, where you can
select which reader you would like to use for receivingt hi s f eed. This concludes

a more detailed look at some of the aspects of the checkout process.

Taxes

t

he

chec
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Tax Rates

Magento allows full control over your storeds Tax Rates, fr

proper term Tax Rate, as defined in Magento, is used to describe a set of up to five individual tax rates, which will

be applied to different combinations of Customer Tax Classes and Product Tax Classes when you create your

Tax Rules. These tax features will be discussed in more detall later in the chapter. To define Tax Rates, navigate

to Sales > Tax > Manage Tax Rates and select Add New Tax Rate .

A

Country - First, select the country associated to this shipping rate. Magento locates the appropriate Tax Rate
by matching the customerds shipping address country to tt
United States from this list, all customers whose shipping address country is United States will have their tax
calculated based upon this Tax Rate.

State - If the country has different tax rates in different states, you can specify the state using this drop-down.
By default, an asterisk will be selected in the drop-down. This means the this Tax Rate will apply to all
customers from the given country, regardless of the state. For most countries, the drop-down will be inactive,
so that you will not be able to specify a state. There are six countries i Austria, Canada, Germany, Spain,
Switzerland, and United States i which have options that can be selected from this drop-down. If you already
created a Tax Rate for the United States, with an asterisk for the state, this will be the standard Tax Rate for
the United States, and will apply to all customers whose shipping address is the United States. However, you
can now create a new Tax Rate, and select California as the state. Now, all orders with a United States
shipping country will use the standard Tax Rate, unless the shipping state is California, in which case it will
use the specific Tax Rate. You can create a Tax Rate for each state that differs from the standard United
States Tax Rate.

Zip/Post Code - If the country or state has different tax rates in different zip codes, you can enter a zip code
in this field. Note: You can specify a zip code even if you have not specified a state. By default, this field will
contain an asterisk. This means that this Tax Rate will apply to all customers from the given country or state,
regardless of the zip code. Therefore, this will be the standard Tax Rate for California and will apply to all
customers whose shipping state is California. However, if the zip code 90064 has different tax rates than the
other zip codes in California (and in this example, it does), you would create another California Tax Rate,
where you specify the zip code as 90064. Now, all orders with a California shipping country will use the
standard Tax Rate, unless the shipping zip code is 90064, in which case it will use the specific tax rate. You
can create a Tax Rate for each zip code that differs from the standard California Tax Rate.

Rate 1-5 - Now that you have defined to which region this Tax Rate will apply, you have the option to define
up to five different tax rates. Tax rates apply at the item level, because it can differ depending on the Product
Tax Class of each item. It will calculate as a percentage of the price of the item. Magento will choose which of
the five tax rates to apply to the item based on the location defined above and which rate is defined in the

Tax Rules. For example, for the standard California Tax Rate, you can define Rate 1 as 8(%), and Rate 2 as
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4, and Rate 3 as 2. For the 90064 zip code, you can define Rate 1 as 9, and Rate 2 as 4.5, and Rate 3 as

2.25.
Country ¥ | United States =]
State * | California |
ZipiPost Code a0064
Rate 1 9
Rate 2 4.5
Rate 3 2.25
Rate 4 0.0000
Rate 5 0.0000

If you navigate to Sales > Tax > Import / Export Tax Rates, you can create a batch of new Tax Rates. You can
upload a .csv file containing a column for Country, State, Zip/Postal Code, and a column for each Rate. First, you
must Browse for the file, and then click Import Tax Rates . This is especially useful if you have many different
regions for which you must create different Tax Rates, because this is much more efficient than creating each Tax
Rate individually. In this page, you can also Export Tax Rates, which will create a .csv listing all saved Tax Rates.
This is useful when first creating Tax Rates, because you can export a blank .csv template, enter your rates

manually, save, and then import this same .csv file.

AT B T @ T T & [ ¥ T & T §H )

1 |Country State  Zip/Post CRate1 Rate? Rate3 Rate4 Rate5 |

L2 (US CA A 8 ol 2| o) 0

(3 |Us A, 80064 H 4.5 225 a a
Tax Classes

Combined with Tax Rates, Tax Classes define Tax Rules. There are two kinds of Tax Classes: Customer and
Product. Each type of class can be created simply by entering a name. The Customer Tax Classes will then be
assigned to individual customers, and the Product Tax Classes will be assigned to individual products. Magento
will determine which tax rate (1-5) to apply to an each item in an Order based on the combination of the

customerds Customer Tax Class and each itemds Product Tax

Customer Tax Classes
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Customer Tax Classes are associated to Customers by assigning them to Customer Groups, which are then
assigned to Customers. By default, Magento will include one Customer Tax Class: Retail Customer. This Tax
Class will be assigned to the two default Customer Groups: General and Not Logged In. You will learn how to
change the Tax Class associated to these Customer Groups, create new Customer Groups, and associate

Customer Groups to Customers in Chapter 6: Customers. If you have different Tax Rules that will apply to

Wholesale customers, you will want to create a new Customer Tax Class.

To define the Customer Tax Classes, navigate to Sales > Tax > Customer Tax Classes.
Click Add New in the top right of the page.

Enter the Class Name (in this case, Wholesale Customer).

A

Click Save Class.

Product Tax Classes

Product Tax Classes are associated to Products. By default, Magento will include one Product Tax Class:
Taxable Goods. If you have different Tax Rules that will apply to Apparel, you will want to create a new Product
Tax Class. You can configure all new products to default to your preferred Product Tax Class by navigating to
System > Configuration, selecting the Catalog tab, and choosing that Product Tax Class from the Default Tax

Class drop-down.

To define the Product Tax Classes, navigate to Sales > Tax > Product Tax Classes.
Click Add New in the top right of the page.

Enter the Class Name (in this case, Apparel).

P w0 DR

Click Save Class.

Clags Hame i

Apparel
Shipping

Taxahle Goods

Note: If you wish to charge tax on shipping, you may want to create a Product Tax Class that will be used solely
to configure the shipping tax. Magento approaches shipping as another item in the Order, so it must be
associated to a Product Tax Class. You can associate it to one of the same Tax Classes that you use for your
products, or create a separate one that is unique for shipping tax. This can be done by navigating to System >
Configuration, clicking the Sales tab, and selecting the Tax Class from the Tax Class for Shipping drop-down. If
you select None, shipping will not be taxed. If do you choose to tax shipping, the rates will be calculated based on

your Tax Rules, just as with any item in an Order.
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Tax Rules

Now that you have established Your Tax Rates and Classes, you are ready to define your Tax Rules. If you need
to have different tax rates for your different combinations of Customer Tax Classes and Product Tax Classes, you
can define a Tax Rule for each scenario. Lustonfess first def i ne

purchasing Taxable Goods. This is what Rate 1 is designated for.

Navigate to Sales > Tax > Manage Tax Rules.

Click Add New Tax Rule in the top right of the page.

Select the Customer Tax Class from the drop-down (in this case, Retail Customer).
Select the Product Tax Class (in this case, Taxable Goods).

Select the Tax Rate (in this case, Rate 1).

@ g & w NP

Click Save Rule.

Now, whenever a Retail Customer purchases a Taxable Goods product, they will be taxed the rate defined in
Rate 1. Customers in the 90064 zip code will be charged 9% of the item price. Customers in the rest of the state

of California will be charged 8% of the item price.

Wholesale Customers, however, are only required to pay half the tax of Retail Customers. Therefore, you would
create a new Tax Rule. Select Wholesale Customer in the Customer Tax Class drop-down, and Rate 2 (which is
half the amount of Rate 1) in the Tax Rate drop-down. Now, whenever a Wholesale Customer purchases a
Taxable Goods product, they will be taxed the rate defined in Rate 2. Customers in the 90064 zip code will be
charged 4.5% of the item price. Customers in the rest of the state of California will be charged 4% of the item

price.

Again, there is another exception to the scenario defined in the first Tax Rule. Apparel is taxed at half the rate as
other Taxable Goods. Therefore, you would create another new Tax Rule. Leave the Customer Tax Class as
Retail Customer, but select Apparel in the Product Tax Class drop-down, and Rate 2 (which is half the amount of
Rate 1) in the Tax Rate drop-down. Now, whenever a Retail Customer purchases an Apparel product, they will be
taxed the rate defined in Rate 2. Customers in the 90064 zip code will be charged 4.5% of the item price.

Customers in the rest of the state of California will be charged 4% of the item price.

But what if a Wholesale Customer purchases an Apparel item? They should be taxed at half the rate defined in
second or third scenarios, which is a quarter the rate defined in the first scenario. Create a new Tax Rule. Select
Wholesale Customer in the Customer Tax Class drop-down, Apparel in the Product Tax Class drop-down, and
Rate 3 (which is a quarter the amount of Rate 1) in the Tax Rate drop-down. Now, whenever a Wholesale

Customer purchases an Apparel product, they will be taxed the rate defined in Rate 3. Customers in the 90064



zip code will be charged 2.25% of the item price. Customers in the rest of the state of California will be charged

2% of the item price.

Tax Rule Information

Customer Tax Class ® ;WH'E@EELE{Dmer j

FProduct Tax Clagss * | Apparel j

Tax Rate * iRate 3 v
Rate 1 '
Rate 2

Shipping Options

Shipping Settings

Configure the Shipping Settings by navigating to System > Configuration and selecting the Shipping Settings tab

in the left column.

Origin

Enter the Country , Region/State , ZIP/Postal Code , and City from where the shipments will be sent (i.e. the

location of your company and/or warehouse). This value will be one half of the equation used to calculate the
shipping rates for the external shipping gateways (UPS,
address will be the other half of the equation. Additionally, if you choose to calculate the tax in an Order based on

the Shipping origin  (which you can configure in the Sales tab), Magento will use the address from these Origin

fields.

Options

A Allow Shipping to multiple addresses - If you select No, your customers can only enter one shipping
address per Order, where all the items in the Order will be shipped. If you select Yes, your customers will
have the option to ship to multiple addresses. A link entitled Checkout with Multiple Addresses  will appear
in the shopping cart, below the regular Proceed to Checkout button . In order to use this checkout method,
your customers must have a registered account, even if you have chosen to allow guest checkout. From this

checkout page, each unit of each item will be divided up. Your customers can quantity to any product in the

UST

l i st , del ete any product, and choose a different addr ess

have the correct one saved in their address book yet).
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The shipping method can be different for each address as well.

Maximum qty allowed for Shipping to multiple addresses - You can determine the maximum quantity that
a customer can enter in the Qty field for each item. When the Update Qty & Addresses button is clicked,
the quantity is split up, so that there is a separate line for each unit. Entering a limit for this quantity would
prevent a customer from entering a very high number, such as 1,000,000, and potentially causing the server

to time out.
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